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INTRODUCTION

Technical Support

DETECTION : Introduction

Prior to contacting technical support, have the following information available:

= Product part number

m Purchase order or order number
= Product serial number

= Current function of the product

m Expected function of the product
= Installation of the product

Return Material Authorization (RMA)

Contact Technical Support to obtain an RMA for any product to be returned. Returns will not be accepted
without an accompanying RMA number. An RMA number is assigned when:

« Tech Support acknowledges a possible product failure.
« A product was damaged during shipping

« Anincorrect product was shipped

« Anorderwas placed using an incorrect part number *

« Anorder was placed using an incorrect part quantity *

« Anorderis no longer required *

* Restocking fees may apply.

Allreturned products are tested to confirm operating failures experienced in the field. If the product is found to be
functional, contractors must absorb expenses for return shipping, as well as the cost and shipping of the
advanced replacement product.

Prominently display the RMA number on all packages sent for return. Ship all return products to:

Warranty Service

Technical Support can replace or repair a defective product when the original purchase is within the warranty
period defined in the sales contract. Check the contract for more information, or contact your sales
representative about your specific warranty period.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 6
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Advanced Replacements

Products that fail to operate in the field can be replaced quickly using the advanced replacement process. The
advanced replacement process is available to all contractors who maintain an acceptable line of credit.

Initiate the advanced replacement process by requesting an RMA number from a Tech Support representative.
Advanced replacements can be shipped to your location when the product is covered under warranty and when
a replacement product is in stock.

« Advanced replacements can be expedited at the request of the contractor. Shipping costs associated with this pro-
cess are the responsibility of the contractor.

« Products returned using the advanced replacement process must be received within 30 days of the RMA issue date.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 7
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INSTALLATION

IMPORTANT! A Media Gateway panel module (S788) or K6012 Interface Card is required to use the L@ti-View
software. These cards only support connections to one computer or workstation.

For information on installing and configuring a Media Gateway panel module, refer to the following documents.
- Media Gateway Panel Module (S788) Information Guide
- Media Gateway Panel Module (S788) Functionality & Configuration Guide

L@ti-View works with

. L@titude

o Compas

o FireNET

o FireNET Plus
« Elite

. EliteRS

Installing the L@ti-View application also installs Openfire© instant messaging and PostgreSQL®© database
software as dependencies.

NOTE L@ti-View is supplied as the application and its dependencies only. Customers must supply their own data
for use with the L@ti-View software. This data can be from a previously created project, or it can be created by using
the L@ti-View design feature after installation.

The install wizard is restricted to repairing or removing L@ti-View if legacy artifacts are found during the install.
Remove the artifacts to perform a clean install.

The latest L@ti-View user guides can be downloaded from the VES Fire Detection Systems website.

System Requirements

These are the basic requirements for installing L@ti-View on a PC.

— Minimum Requirement Recommended Requirement

Processor Intel® Pentium™ P4 32 bit CPU Intel® Core™ i5 64 bit CPU

RAM 4 GB 16 GB

Hard Drive Size 120 MB 500 MB

Display 800 x 600 1280 x 768

Internet Connection Internet connectivity is necessary to perform updates and to take advantage of some features.

USB Port USB 1.0 port USB 2.0 port

Operating System Windows 7 Pro 32 bit Windows 7 or 10 Pro 64 bit

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
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Installing L@ti-View

IMPORTANT! Administrator rights are required for L@ti-View installation.

NOTE Referto Repairing L@ti-View to troubleshoot any difficulties during installation.

Installing the L@ti-View application also installs Openfire© instant messaging and PostgreSQL®© database
software as dependencies. L@ti-View is supplied as the application and its dependencies only. Customers must
supply their own data for use with L@ti-View. This data can be from a previously created project, or it can be
created by using the L@ti-View design feature after installation.

1. Create a system restore point and back up all desired data before proceeding.

2. Export any current L@ti-View configurations before upgrading, repairing, or reinstalling.

3. Insert the L@ti-View installation USB drive.

4. Launch the installer and accept the UAC warning and the License Agreement.
NOTE The software will install in C:\Program Files\Hochiki (Windows 32 bit), or. C:\\Program Files
(x86)\Hochiki (Windows 64 bit). @

LTIV IET

Choose or create a Start Menu folder (optional) and click Next.

Remove the dongle and click Install.

Wait for the software to install and perform the (license) Dongle Self-Test.

Click Finish to restart the PC and initialize the software and databases.

Click the L@ti-View desktop launch icon to start the application.

10. Consult with IT staff to configure L@ti-View to automatically start whenever the PC or Server is
rebooted.

© 0N o

The L@ti-View Supervisor Service, Openfire, and PostgreSQL are set to start and run in the background when
the workstation is booted up. Do not disable these automatic starts as the L@ti-View 2D GUI must be able to
connect with them when it is manually started.

NOTE Automatic restarts should be considered where IT systems are not using Uninterruptible Power Supplies
(UPS) and are left unattended for any periods of time.

NOTE L@ti-View is designed to run permanently and cannot record or respond to any events if it is not running.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 9
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Connect to a Fire Panel

IMPORTANT!

In the Media Gateway settings, the MCE setting must be enabled in order to connect to a fire alarm

control panel. This can be done via the panel or LE2.

L@ti-View works with a number of different fire alarm control panel types. The following steps explain the panel
connection process.

1.
2.

4.

Loginto L@ti-View using Administrator level credentials.

Click Fire Configuration in the System Configuration Menu (or from the main menu bar select View > Show Page
> Fire Configuration).

Normal Operation

Fire Configuration Page
#  Mlarm Config
« Panel Comms e

Alarm Status u Setup Connection to a Fire Panel
B Archiving (3 Fire Configuration
Connect to panel

ey Fire
£Account Management. Panel Type:

Hochiki Latitude (UL) -
192.168.147.121

& Fire Configuration

(@ workstation Config IP Addrass:

Panel connectivity test

e

[ connectivity established. ]

On the Fire Configuration page, select the Panel Comms tab, select the appropriate panel type and enter the

IP address of the Media Gateway. The Media Gateway Card IP address can be found by accessing the LAN (Local
Area Network) settings on the panel.

From the Panel Connectivity test, click Test to connectivity.

The computer should be configured with a static IP address in the same range as the target panel IP address.
Navigate to Control Panel > Network and Sharing Center on the computer or workstation where L@ti-View
is installed. Select Ethernet > Properties. View the properties of the Internet Protocol version and use an IP
address in the same range of that of the panels Media Gateway Card.

Importing Loop Explorer 2 Configuration Data

Itis necessary to import the fire alarm system configuration data into L@ti-View . The following steps detail the
process:

1.
2.

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide

Log in to Loop Explorer 2.
From the File tab, select Export Guide Data.

Browse to the desired location on the computer.
Name the export file by entering details in the File Name field.
Select the radio button for Guide (Version 2).

Version 1.00 | May 2020 | MAN-1443COM
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3. Click Save.

NOTE When importing from Compas panels, the .xml configuration file can be used.

4. Returnto L@ti-View and select Fire Configuration from the System Configuration Menu. Select the
Fire Configuration tab.

5. Select Import..., browse to the save location of the LE2 configuration data file and click Open. The data will be
imported and will populate the Fire Configuration Page.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 11
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Repairing L@ti-View

L@ti-View and all its dependencies can be fully repaired, or incrementally repaired.

An unsuccessful L@ti-View-only repair can be repeated with Openfire and/or PostgreSQL selected. If this
second attempt fails, a complete uninstall/reinstall procedure should be performed.

NOTE Repairing L@ti-View causes the wizard to uninstall and reinstall the selected components. Ensure that
L@ti-View configurations and projects have been recently backed up or exported prior to executing the repair.

To repair L@ti-View using the installation repair tool,

Exit L@ti-View and remove the dongle.

Start the L@ti-View installation program.

Authorize UAC to change computer settings.

Select Repair and click Next.

Select the dependencies to include in the repair and click Next.

Ensure the details are correct and click Repair.

Wait until the uninstall is completed, check that the dongle is removed and click Install.
Select one of the options below and click Finish.

O NoakwN =

NOTE The repair procedure does not verify the dongle. However, an out of date or faulty dongle will prevent logging
into L@ti-View.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 12
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Uninstalling L@ti-View

Use the L@ti-View Installation software removal tool to uninstall L@ti-View and its dependencies. Do not
uninstall Openfire or PostgreSQL if they are used by other programs or if L@ti-View will be reinstalled with the

same configuration settings.

NOTE Print or save all reports, and save or export the current project prior to uninstalling any software.

To uninstall using the installation software,

1. Exit L@ti-View.
2. Runthe L@ti-View installation program.
3. Select Remove and click Next.

Lati-View Program maintenance
Repair, or remove the Lati-View proagram.

) Repair
_—-' i Repair errors in the program. This option fixes missing or corrupt files,
ﬁ shortcuts, and registry entries.

@ Remove
Remaove the program from your computer.

[ Mext = ] [ Cancel

4. Select the check box to remove all configuration and program data and click Next.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 13
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Lati-View Remove Program Data
Remove Lati-View configuration and program data page.

e
a Remove all Lati-View configuration and program data

< Back ][ Mext = ][ Cancel

5. Select whether to remove KEYLOK, Openfire, and PostgreSQL, and click Next.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 14
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\
Setup - Lati-Vi =1L i

Optional Packages Uninstall
Optionally uninstall third party packages assocated with the Lati-View software.

Flease select the third party packages you wish to remove as part of this uninstall.
Click next to continue.,

KEYLOK (usbkey) USB

Openfire 3.8.1

PostgreSOL 8.4

< Back “ Mext = I[ Cancel

6. Onthe next screen, click Uninstall.
7. Reboot the computer or workstation to finish the uninstall.
8. Confirm that the following software has been removed:

» ASL Patched OGRE

o ASL Qt Express

« Keylok Driver (Windows 7) (option)

. L@ti-View

« Openfire

« PostgreSQL

« Windows Driver Package - KEYLOK (Windows 10)

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 15
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ACCOUNTS AND ACCESS

@ti-View Dongle

A valid license USB license dongle must remain in
place for the duration of the L@ti-View session. Its
removal will prevent additional logins and will disable
L@ti-View after a period of time. The USB dongle is
encrypted and contains a license for one machine only.
It must remain installed for the 2D GUI to continue
running. USB license dongle

L@ti-View and its dependencies will run in the background. Log in with an appropriate user account and
password to interact with the software, acknowledge alerts, silence buzzers, etc.

Default User Accounts

L@ti-View is supplied with four levels of default user accounts and passwords, which should be changed
following the software installation. The default accounts and passwords are case sensitive and are:

Administrator admin
Maintainer maintainer
Manager manager
Operator operator

Itis advisable to have at least two Administrator accounts, as lower levels cannot change passwords or account
details for higher levels.

NOTE Three incorrect tries will lock L@ti-View for 60 seconds. All login attempts (successful or failed) are time-
stamped and recorded in the Event Log.

Logging In and Out
Log In

Tolog in, enter the appropriate credentials in the Log In window.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 16
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ra '
& Login -2 [

Log In

g Lisername

. Passward

L A

Log Off and Exit

Accounts and Access

Only alogged in user with Administrator level access can close (exit) L@ti-View safely. Using any other method
(e.g., Ctrl-Alt-Del) could result in software corruption or loss of data.

1. To log out, click the Log Off icon in the toolbar, or File > Log Off.

2. To exit, click File > Exit.

User Groups

There are four default User Groups plus optional custom user groups, and each group can be assigned with
custom User Group tokens that are used to grant or deny access to specific L@ti-View components. This table is
a guide, but Administrators can create customized user accounts or access levels to match their own

requirements.

3 3 2 1
Task .
SysAd Maint. | Manager | Operator
Yes Yes Yes Yes Yes

Log In

Fire maintenance functions
Access operational procedures
View Active Events

View Active Fires

View Cause and Effect Strategy
Poll Device Analog values
Manual refresh device status
Disable / Enable Devices
Disable / Enable Zones
Acknowledge Events

Acknowledge Fire Events

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

Yes Yes
Yes Yes
Yes Yes
Yes Yes
No No
Yes Yes
No No
Yes Yes
Yes Yes
Yes Yes
Yes Yes
Version 1.00 |

Yes
Yes
Yes
Yes
No
No
No
Yes
Yes
Yes

Yes

May 2020 |

No
No
No
No
No
No
No
No
No
No
No

MAN-1443COM
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Task
SysAd VET 8 Manager Operator

Manual Evacuation

Reset Fire Devices

Silence Alarms

Silence Buzzer

System Alarm Acknowledgment
System Alarm Unacknowledgment
Local alarm (PC) volume control
Clear Hard Troubles

Disable / Enable Alarm Reporting
Clear Alarms

Find Mode

Select Mode

Fire System Topology View

Export tables

Generate Reports

View Historical Events

View Maintenance Log

Fire Mode in 2D GUI

Fire configuration

Fire simulation mode

View System Information page
View Fire Management GUI
Operate/Restore Outputs

Save Column Widths

Change Own Password

Account Management (Edit/Create/Delete users)
Database management and editing
Workstation Configuration

Use 2D Editor mode

Exit L@ti-View

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

Yes Yes
Yes Yes
Yes Yes
Yes Yes
Yes Yes
Yes No
No No
No No
No Yes
No No
Yes Yes
No No
Yes Yes
Yes Yes
Yes Yes
Yes Yes
Yes Yes
Yes No
Yes Yes
Yes Yes
Yes Yes
Yes No
Yes Yes

No No
Yes No

No No
Yes No
Yes No
Yes No

Version 1.00 |

Yes
Yes
Yes
Yes
Yes
No
No
No
No
No
Yes
No
Yes
No
Yes
No
Yes
No
Yes
Yes
Yes
No
Yes
No
No
No
No
No
No

May 2020 |

No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
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Change User Passwords

1. Loginto L@ti-View with an appropriate account level.

2. Click Account Management from the System Configuration Menu, select a user name (or add a new one), and
select Change Password.

3. Enter the required details and click OK.

& B & om Normal Operation

@ pYetid Account Management

& MamConfi 48 vancg &

= Alarm Status ‘Q

Username Description

Administrator

Maintainer

| [ shom assigned items oniy

itted to administer the system
the system.
ators.

[ show password

((2Jimport | [ &) export | [ZsRefresh | [ @yadd | [ 2 clone | [ @pekete © Accent | [ @ cancel

Logged on as: Administrator Workstation ID: box01a Orline 5/25/2020 4:58:00 PM

System Administrators should decide if they want to use individual user accounts, or role-based user accounts
with shared passwords, or a mixture of the two. Individual accounts are more secure than shared accounts and

can be used to control or block access by individuals, whereas a shared operator account might be useful in
locations where L@ti-View runs constantly.

All users must manually log off at the end of their session. All log in, log out, and exit events are time stamped in
the Events log. Failure to log off could allow another user to perform unauthorized actions.

Change Individual Password

Click File > Change Password... and enter the desired details in the Change Password window.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 19
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r '
{5 Change Password M

Change Password

£ Username Administrator

Old Password
=+ Mew Password

> Mew Password {confirm)

[ Change Password ] [ Cancel

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 20
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GUI OVERVIEW

GUI Overview

The L@ti-View interface is highly editable, and therefore may not look exactly as shown. L@ti-View gives
building managers complete monitoring and control over fire detection, providing a comprehensive fire risk and

incident management system.

Ele View Tools Help

Y BRI Normal Operation

@ DaEur
% Alarm Conf i Control Mode

)

evel
evel +:
evel

FE

F Archiving

Knole Building

3

2
+1
Bt
2

evel
evel
& Fre Configuration

(@ Workstation Config

L T el X

kSvnln 2y Srdul AT |

7

N

*fi’-?i ik

Displayed Zone Type: Detection Zone v

[Freioce

Projectloaded ‘

GUI Menu

Logged on as: Admiristrator. Workstation ID: boxd1a Oriine 5/21/2020 2:48:00 PM

File

« Log Off
« Change Password...
« Exit

« Show / Hide Main GUI [F5]
o Show Home Position

o Show Page >

« Save Settings [Ctrl + S]

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide

Version 1.00 |

May 2020 |
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Tools

o Alerts Volume

Toolbar Icons

Description
Log Off
Toggles between the current Configuration and the Home Screen

Show Home position

&@@&E

Search

System Configuration Menu

The System Configuration menu is located on the upper left-hand side of the GUI. The System configuration
menu displays account-specific options. Detailed information regarding configuration options can be found later
in the document.

@ 2D GUI

g ® Alarm Config

Alarm Status
By Archiving
& Fire
ca‘.ﬁ.::count Management

¥y Fire Configuration

-.Q:I Workstation Config

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 22



NES

Control Mode

FIRE .
DETECTION
SYSTEMS @ g ©

: GUI Overview

Control Mode

| select

| | & Fire

Select

Fire

The Control Mode tool bar is located in the main section of the interface, when
in the 2D GUI tab.

Select Mode allows navigation of the GUI via menus, buttons, hotspots, and
macros.

Fire Mode allows the user to filter the results by:

« Detection Zones
« Evacuation Zones
« Operational Zones
« Manual Evacuation

When there are active events on the system, a box will appear in front of the GUI providing information about that

File View Tools Help
@& [Ea n Normal Operation
@ == Level +3
& Control Mode
Level +3
Level 12
Level O
Level +1 =
Level -1 Flre
P Incident Time: 07:28:51
Detection Time: 5/25/2020 12:08:45 PM
= DZone: Unknown 07:28:51
(@ Workstation Config Device: Unknown
Panel: Unknown Loop: Unknown
Location: Unknown B3
i
S
I
AN
AN
Cl
4
=]
[selct voce Unsaved changes,

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide Page 23
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Editor Mode

The Editor Mode toggle button is located on the main section of the interface in the lower left section. Detailed
information about editing options can be found later in this document.

[A

Version 1.00 | May 2020 | MAN-1443COM
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2D GUI EDITOR MODE

L@ti-View’s editing mode can be used to design or edit site plans using a variety of shapes, texts, function
buttons, and macros. The editing mode also allows creation or editing of item and plan level properties via panels
and sub-menus (Some fields may have been pre-populated by the New Project wizard, but they can be edited if
required).

Project Navigator Panel & X
[:] [Etevels |« symbols | I Object Model Sidebar

E NP

Properties Panel | _Filter Items Panel

L3

‘Emmr Vode No project loaded.

All panels are visible and docked by default when Editor mode is first opened, but can be dragged, floated,
minimized, or closed as required. Toolbars are horizontal or vertical, depending on their location. L@ti-View
saves previous choices until the next session. However, Editor preferences can be saved using View > Save
Settings.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 25
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Primary Editing Toolbar

The GUI Editor Primary Editing toolbar (across the top of the GUI) contains standardized icons that can be used
to apply various actions to selected items. Every icon has a hover tooltip for easy identification.

|| NEW PROJECT ]
| OPEN PROJECT i

RESTORE PROJECT L] |

SAVE PROJECT =
[, SAVE PROJECT VERSION 2
"2/ RELOAD PROJECT =|
[l EXPORT PROJECT =
@ CuT il
Ly copy =
PASTE i
@ UNDO ry
.~ REDO 2
'L GROUP SELECTED ITEMS D}
%% UNGROUP SELECTED ITEMS oy
< LOCK SELECTED ITEMS :‘:
~% UNLOCK SELECTED ITEMS —.
™ SEND SELECTED ITEMS TO FRONT &
' SEND SELECTED ITEMS TO BACK 3
“I' MOVE SELECTED ITEMS FORWARD
wadl

MOVE SELECTED ITEMS BACKWARD
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VERTICAL ALIGN TOP
VERTICAL ALIGN CENTER

VERTICAL ALIGN BOTTOM

HORIZONTAL ALIGN LEFT

HORIZONTAL ALIGN CENTER
HORIZONTAL ALIGN RIGHT

SIZE SELECTED ITEMS TO THE

SAME WIDTH AS THE FIRST ITEM

SIZE SELECTED ITEMS TO THE

SAME HEIGHT AS THE FIRST ITEM
DISTRIBUTE SELECTED ITEMS VERTICALLY

DISTRIBUTE SELECTED ITEMS HORIZONTALLY

ZOOM IN
ZOOM OUT

RESET ZOOM

TOGGLE GUIDES DISPLAY

" TOGGLE GRID DISPLAY

EDIT SYMBOL LIBRARY SETTINGS

EDIT PROJECT SETTINGS

TOGGLE ALARM FLAG PLACEHOLDER VISIBILITY
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Toolbox Toolbar

2D GUI Editor Mode

The Toolbox toolbar (down the side of the GUI) provides standard drawing tools that are used to add items to the
currently displayed level. Each tool may provide additional editor functions that will be displayed in the Active
Tools actions toolbar. Each icon has a hover description, and the editor status bar (at the bottom of the screen)

displays the active tool's name.

SELECT AND EDIT ITEMS

Enables point and click to select items or groups.

A ADD TEXT ITEMS

Opens the Text toolbar and enables point and click text insertion. Text can be edited for Font,
Font size, Bold, Italic, or Underline, RGB Color, and Background type. Inserted text can be edited
when not locked.

Il ADD RECTANGLE ITEMS

Adds rectangle shapes to the image.

= ADD ELLIPSE ITEMS

Adds ellipses and circles that can be edited, overlapped, or cut to make other shapes or callouts.

ADD REGULAR POLYGON ITEMS

Adds regular polygons that can be rotated and edited.

ADD POLYGON ITEMS

L

Adds freehand polygons by clicking to define freehand points and lines. The fill style adds
shading between connected points, and shapes can be overlaid to show 2D-relief styles.

ADD LINE ITEMS

Adds straight lines at any angle. Lines can be edited for color, weight, and axis.

5O\

ADD ZONE ITEMS

Allows you to freehand draw Detection Zones, Evacuation Zones, and Operational Zones, which
become shaded as you draw. Different zones can overlap.

ADD HOTSPOT ITEMS

Allows you to freehand draw hotspots, which become shaded as you draw. Different hotspots
can overlap.

ADD NAVIGATION BUTTONS

This tool adds pre-defined navigation buttons (with optional icons) at your chosen locations.

=

ADD MACRO BUTTONS

Tool Options

This tool adds pre-defined macro buttons at your chosen locations.

The context sensitive toolbar may be blank, or it may display additional controls for the selected tool. All individual

tool options are shown below.

Select and Edit Items

Selecting overlapping polygons will open an additional toolbar that will allows merging or transecting the selected

objects.
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MINUS BACK
MINUS FRONT
MERGE
INTERSECTION
a &0
(flame aw/ rgaEE
svoke st P
Fill Style | solid ~|
Minus Back Subtracts the objects in back from the frontmost object.
Minus Front The frontmost objects will be cut out from the back-most object.
Removes the part of a filled object that is hidden. Removes any strokes and merges any adjoining or
Merge . . .
overlapping objects filled with the same color.
Intersection

Traces the outline of the region overlapped by all the objects.

Add Text Items
s[(dm @ a® /28 EHE

Font MS Shell Dig 2 v Size: 8Pt [T @

Color [ ]
Background Mone v] |§|
Add Rectangle Items
v AlE]e a B/ 2B EE
Stroke Style 1 2l
Fill Style [Nune T] |§|
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Add Ellipse Items

s A E(e]aw /s rEEE

svoke st L e m

Fill Style [Nune - ] |§|

Add Regular Polygon Items

v AE oA/ EEE
StrokeStyle [Soid  v| 1 2] (W

Fill Style [Nune - ] |§|

Points & (=] (@)

Add Polygon Items

s AE® A/ REEE

Sk s =l

Fill Style [Nune - ] |:|

Add Line Iltems

s A E® AR /R EEB

swoke st =l

Start Cap [Nune - ]

End Cap [Nnne - ]
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Add Zone Items

s AE® AR /(faBEE

Zone type |Detection Zone
Detection Zone

-

Evacuation Zone
Operational Zone
PA Zone

Add Hotspot Items

v A E e AR/ BEEB
Stroke Style [DashDotDot v | 2 [+ [l

-

Fill Style |Cross

)

Add Navigation Buttons

A E e AN/ R EEHE

Font Ms Shell Dig 2 v Sizer 8Pt 5 @

Mo Icon hd ]

Icon l

Accessory Icon

Z right_arrow_alpha.png -
ﬁ house_go.png
@ information.png
o~ key.png
@ layers.png
4 left_arrow_alpha.png
@' lightbulb.png
@' lightbulb_off.png

- lightning.pna
& link.png
1 lodk.ong a2

-

[
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2D GUI Editor Mode

NES

Add Macro Buttons
m_gﬂurjai.}flﬂiﬁil
Font M5 Shell Dig 2 v Size: 8Pt [T @
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Project Images

Before creating a new project, it is important to understand how the software organizes the operational part of
the project.

Create and assemble all necessary project images before starting a new project. This may already have been
done if L@ti-View was installed on other machines and the project was saved to a server. To access the saved
project, click Open Project and load the project data.

Images, symbols, and icons are imported at 1:1 resolution. Resize them as desired before changing their
settings. L@ti-View supports most image types, but *.png sized at 9 x 9 mm are recommended for consistency
and clarity.

When importing background images, choose between scaling them to fit on screen or moving them around the
screen using slider bars.

When saving projects and resources, save them to a backed-up server where they can be accessible from other
workstations.

Image Types

Create and save:
« Oneimage of the site or building for the Home page level
« Site and/or individual floor plans for the additional levels
Supported image file types are .bmp, .gif, .jpg, .jpg, and .tif.
Level images should be approximately 2000 pixels wide 1000 pixels wide (150 dpi).

NOTE When creating a new project, a selection of commonly used symbols are found within the symbols folder.

Saving Images and Icons

L@ti-View creates and populates a basic project folder, but it is possible to manually create and populate a
project folder.

Save symbol images in the user folder. Additional folders can be created anywhere within the parent folder; e.g.,
a separate ‘levels’ folder may be desired for site and floor plans.

x-y Coordinate System

The 2D GUI uses the standard x-y screen grid where the point of origin is the top left corner, and the item
coordinates are its center point. Object center coordinates can be offset to avoid conflicts with adjacent items.
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x - AXIS
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Fire Symbol

x 52
y:22
w: 50
h: 50

y - AXIS

Z - Index

The 2D GUI uses a virtual-layer system for ordering items according to their priority. These layers are achieved
because L@ti-View automatically creates ‘z-axis’ depth bands (the Z-index) as items are being added in Editing
mode.

The background image layer will always be the lowest layer, and higher priorities will always be displayed on top
of lower priorities, as shown.

CONTROL MODE HUD LAYER

ALERT FLAGS LAYER
SYMBOLS LAYER

ZONES LAYER
BACKGROUND IMAGE LAYER

While an item’s Z-index can be manually altered in Editing mode, this is not recommended as it could adversely
affect other items and alert flag priorities.

NOTE Layers are different than levels. Levels are equivalent to floors in a building, while layers refer to where an
object is ordered on the z-index.
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Project Navigator Panel

The Project Navigator Panel has tabs that provide quick access to the current project levels, symbols, and
subsystem object tree information.

Levels Project Mavigator Panel F X
« Seethe current plan level Levels | 4/ Symbols | % Object Model | Sidebar ‘
« Select and view another level in the background " i
« Add or remove plan levels - g Level +3 fa B
« Edit aplan level’s properties and image |_=HE

Levels that have been edited, but not saved, are highlighted | |1 ‘el +2

in pink.

The level being viewed and selected for editing are
highlighted in blue.

Level +1

< | Level -1

S Level -2 -

[ Add ][ E Remove ][l__él,. Level Properﬁes]

Symbols Project Mavigator Panel 5 X
[ Levels | <&/ Symbols | I[E Object Model Sidebar
« Drag and drop pre-defined symbols onto the selected level Editsymbol lrary setings:[|_]
« Edit the symbol libraries (import or delete symbols) & e _
L] =) ) e S s 8 4 el ) B M BT
T L |25 8 | e |5 R ¢ | @S] & -
fie | @] © | 2 | 5] 25| B8 = | =) 0 || | D R e
S| < [[ElEE -
9 pa -
‘Gj user -
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Object Model

« Select a sub-system to view

« View Object Model paths in expandable tree view
« View the Equipment List by item Name and JPC Path

» Hide or show items
« Highlight orphaned items

Sidebar

« View the plan levels that appear in the Sidebar
« Rearrange the order of levels
« View unassigned plan levels

« Transfer levels between the unassigned and assigned lists

2D GUI Editor Mode

Project Mavigator Panel f X
Levels [ Object Model Sidebar
Select subsystem [ ¥ Fire - ]
= objectTree | Equpmentlist | &9 P Zones |
Q, search |
Path | Value | Location =
E 1 L@ti-View
[=h- ;2 Fire
= Activelnstance boxlla
Config Mismatch
-k Fault
=7 Node 01 Fault
25 Description  AUTO CONFIG...
FASID Node 01
Loops
w22 Name L@titude
@ status Fault
E%' status MNormal
£ 4% Zone:
[= 2 Detection Zones
[ 3 DetZonel001 Zonel LI
[Hide placed items][shaw all items Find unmatched placed items
Project Mavigator Panel g X
| Levels | uf Symbals | I[%) Object Model | Sidebar |

Unassigned Levels

Sidebar Levels

Level 0-5

Level +3

] »

Warning -
Warning -
Warning -
Warning -
Warning -

Level 0
Level1
Level -1
Level 2
Level 3

NOTE The item moved to the top of the Sidebar tab’s
‘allocated’ list automatically becomes the L@ti-View Home
page, which will be indicated by the Home icon appearing on

that level.

VES Fire Detection Systems
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ZOME 001

ZONE 002

ZOME 003 [LEVEL +1]
ZONE 003 [LEVEL 0]
ZOMNE 003 [LEVEL -1]
ZONE 003 [LEVEL -2]
ZOME 004 [LEVEL +1]
ZONE 004 [LEVEL 0]
ZOME 004 [LEVEL -1]
ZONE 004 [LEVEL -2]
ZOMNE 005

ZOME 006 [LEVEL -1]
ZONE 006 TLEVEL -21

Level +2
= Level 0

Level +1
Level -1
Level -2

=&

(aliv]
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Properties Panel

The Properties Panel has tabs that allow the creation or editing of a selected item’s properties. All screen items
have properties that can be created or edited in the Properties Panel tabs. Some properties automatically
change when moving or resizing items manually. To view the properties of an item, select an item to be edited.

Explanations of the different properties are shown below, but the properties are context-sensitive and may not
be visible at the same time.

NOTE Property changes are disabled when selecting multiple items at the same time.

The Properties Panel supports drag-and-drop from the object model tab. The following properties can be
configured using either manual entry or drag-and-drop:

. JPC Path
« Name (JPCID)

Properties Panel =
.7 Base * Appearance | ;éf Flags | ', Troubles
_ IPC Path
« JPC Path. The related subsystem equipment’s JPC path.
Mame Plotted Hotspot 3

« Name. The unique name of the item or button.
« Description. Optional short description text displayed in Description
the item status information window. Location

« Location. Optional location name e.g. ‘Arrivals Hall’.

« Contains Path. Optional comma separated list of
additional subsystem JPC paths that drive the alert status
flag.

« Target. The location that L@ti-View will jump to when
clicking on the item or button.

Contains Path

Target knole_building -

Properties Panel Filter Items Panel

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
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Bounds

« X. The object’s normal centre point x-axis coordinate

(without offset).
« Y. The object’s normal centre point y-axis coordinate
(without offset). Properties Panel ]
« Width. The width of the item in pixels. _iBase | ¥ Appearance | < Flags | .\, Troubles ‘
« Height. The height of the item in pixels. Sounds
ZIndex. Measured in pixels, adjusting the values, the Y axis X 1031px @)

changes the ‘height’ of the symbol. Symbols are allocated Z-
Index numbers in the order they are added, so it is possible

¥ 31 px (=] (=] (@)

to stack a symbol on other symbols depending on their z- Width 313 px @
index (e.g., a Sounder with index 100005 could sit on top of Height 280 px B
BGU 100004 but would be below BGU 100007). This could sindex [ 100003 B

be possible where the user adds and defines a hotspot or
macro button, and afterwards adds and drags a symbol on
top of it for ease of identification.

Z-Index numbers can be manually edited, but this is not
recommended as it is not possible to know what numbers
are already in use or what may be used in the future. Itis Propertics Panel | Filter ftems Panel
also not recommended to change the number of Os in a Z-
Index, as they control the z-layer alert priority bands (e.g., a
zone would be 100x whereas a symbol would be 10000x).

The Z-Index of the base layer image cannot be changed, as
it is always the lowest fixed level.

Offset Properties Panel =

« X. The horizontal offset from the object’s center point to sBase | * Appearance | o Flags | S |
the center of the displayed alert flag, in pixels. This can be

L. . Offset
a positive or negative numper, e.g. 50px or -50 px. For X 0px @
zones, the polygon center is offset.
« Y. The vertical offset from the object’s center point to the ¥ [A0px @
center of the displayed alert flag, in pixels. This can be a Drop Shadow

positive or negative number, e.g. 50px or -50 px. For
zones, the polygon center is offset.

Drop Shadow. The alarm flag’s drop shadow can be on or

off.
Properties Panel Filter Items Panel
VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
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Transparent. Specifies whether the object is transparent to  properties panel 5
troubles. Transparent objects still display troubles, but they [ GBase | ® Appearance | < Fiags | /.. Troubles |_
are propagated to their parent entity.

Transparent |:|

Properties Panel Filter Ttems Panel
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Filter ltems Panel

2D GUI Editor Mode

This panel allows the filtering of on-screen items, which can
be useful when there are a lot of screen objects displayed,
or when objects are affected by objects on different layers.

Items can be filtered by type or name. Use the torch icon to
select or deselect all items in the list.

To filter items,

1. Select the desired level in the Project Navigator.
2. Select the Filter Items Panel.

3. Select the desired filter tab.

4. Use the check boxes to select individual items.

NOTE The Filter by name tab is context-sensitive and
will only show the items already included on that level.

Filter Items Panel

o Filter by type

A Filter by name

Detection Zone
Evacuation Zone
Fire Symbol
Generic Symbol
Hotspot

Line

Macro Button
MNavigation Button
Operational Zone
PA Symbaol

P& Zone
Palygon

Text

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide

| Properties Panel

Filter Itemz Panel
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2D GUI PROJECT SETTINGS

New projects always start with default settings, which can be edited, or reset to default, at any time. Click the
Edit Project Settings button.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
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General Settings

DETECTION o 2D GUI Project Settings

(3 Project Settings B ||
L General settings 3‘,‘ Manitored Subsystems o:: ‘endor Logic Rules | =l Change Log
Praoject Name test_project
Project Path C:\Users\cgera\Desktop\WES \LatiView\test_project
Praoject Description
Title Prefix
Scene size width [} 1510 (2] Heant ] w0 ()
Default background color I:I
W Preview
Size D 45 v =
Offsetx [ 0
Offsety [ 40
Opadity [ voo [= f
Attract animation duration {secs) D 5 PA Zone
Drop shadow enabled
Drop shadow color D
Drop shadow opacity D 0.70 @] =

[7] cyde zone states

s

The top of the window contains general information about the project. Any changes can be reset or cancelled.
The Project Name and Path are auto-filled. Enter the desired Project Description and Title Prefix. The
Scene Size measurements are in pixels.

The bottom of the window has two tabs - Flags and Zones.

The Flags refer to alert icons and their placement on the background graphics. The flag offset refers to the
center coordinate of the flag, which can be offset if concurrent flags are very close to each other.

The Cycle Zone States checkbox allows the preview image to cycle through the color states set in the Zone tab.

The Zones tabs contains a list of the alert states, each showing their default color overlay, which can be
visualized on the preview window. Each state has a drop-down box showing the alternative colors or cross-
hatching styles; e.g., visually-impaired persons might benefit from using cross-hatch instead of color overlays. A
slider provides the ability to control the opacity.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
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Default background color l:‘

/' Flags %/j Zones

|
“.# General settings | @ Monitored Subsystems I .= Vendor Logic Rules | [=] change Log ‘
Project Mame test_project
Project Path C:\Users\cgera\Desktop\VES Latiview\test_project
Project Description
Title Prefix
Scene size width —{_} 1610 (@) Height L] 70 (@)

Preview

Opacty 0 o)
Evacuation state Disablement state [ Vellow ']

Test state ’ Yellow '] Selected state

’,//‘ Black Stripes - ]

II PA Zone

VA Priority 1 WA Priority 2 ’ Orange - ]

WA Priority 3 ’ Yellow - ] Busy Overridable

Error ’”/‘Red Stripes '] Listen In ’ Pink '] I
i BGM - Green - | Mute [\\\‘ Green Stripes (Rew) - ] [ Cycle zone states I
| I
! |
VES Fire Detection Systems Version 1.00 |
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Monitored Subsystems

2D GUI Project Settings

The Monitored Subsystems tab lists the monitored subsystems in the network. These can be deselected if

required.

& Project Settings

12 [t

. General setfings | i Moritored Subsystems | = Vendor LogicRules | | Change Log
stems to moritor:

VES Fire Detection Systems
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Vendor Logic Rules

The Vendor Logic Rules allows customized flags to be added or duplicated using JCOP/Openfire processing
rules. More information can be found on https://www.igniterealtime.org/projects/openfire/.

f (3 Project Settings M‘
2 General settings | g] Monitored Subsystems ‘,:: vendor Logic Rules | = Change Log
Item lookup rules

Rule Name JPC Path Reg Expr Info Item Value Item Type Symbol ol
ACA-E Multi Sensor Product 21614 Fire Symbaol ﬁ multi.bmp ‘E|
ACB-AS/ACB-ASW Heat Sensor Product 155184 Fire Symbol V& heatbmp
ACB-E Heat Sensor Product 15380 Fire Symbol E heat.bmp
ACC Multi Sensor Product 248167 Fire Symbaol - multi.bmp
ACD-V Multi Criteria Sensor Product 217263 Fire Symbaol L4 multi.bmp
AIC/AIC Ion Sensor Product 168.13 Fire Symbaol 1= icn.bmp
AIE-EA Tonisation Sensor Product 168.24 Fire Symbol F;"“ ion.bmp
ALE/ALG/ALK Photo Sensor Product 13611 Fire Symbol o photo.bmp
ALG-V Photoelectric Sensor Product 13822 Fire Symbaol L=4 photo.bmp
ALK-V Photoelectric Sensor Product 250135 Fire Symbaol L=4 photo.bmp
ALN Photoelectric Sensor Product 247168 Fire Symbaol L=4 photo.bmp
AMS Pull Station Product 6.99 Fire Symbaol # pull_station.bmp
ARB Relay Base Product 71172 Fire Symbol 3 relay_module.bmp
ARB-IRelay Base Product 71173 Fire Symbol 3 relay_ modulebmp
1 1 | +
[ ©add |4 pupicate ][ 3¢ pelete |

s

L8 A

Click Add to add a new rule. The Define new item lookup rule window appears. Enter the desired rule
criteria.

r ™
3 Define new item lookup rule m

Please spedfy a JPCPath regular expression or data point name and value,

Rule Name
Data point name
Data point value

JPC Path reg expr

Item type [Fire Symbol - ]
Symbal [Nona - ]
Priority 0 0

[7] keep dialog open

T T

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
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Change Log

The Change Log tab records all changes made to the project.

[ (3 Project Settings M1
;2 General settings I i/ Monitored Subsystems = vendor Logic Rules | [=] change Log
Change Log:
Datetrime User Comment
19/03/27 15:03:59 |k Changed Node 8 Loop 1 Address 18

I

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
L@ti-View Installation and Configuration Guide Page 46



Creating a New Project
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Inthe 2D GUI set to Editor mode and logged in as an Administrator, click the New Project button. The New Project

window appears.

Project Name. (Required) Enter a name for the
project.

Project Location. (Required) Click Choose and
browse to the desired save location.

Project Description. (Optional) Enter a description
for the project.

Title Prefix. (Optional)

Scene Size. (Optional) Type in the scene width and
height in pixels (default setting is the monitor
resolution). Choosing the wrong size will cause the
images to scale to the wrong size, which will create
sliders for moving the scene, but may also hide some
buttons and features off-screen.

NOTE Make the background size the same as the
image being inserted.

Default Background Color. (Optional) Click the
square button to select a background color. It is also
possible to input RGB or HSV values.

2. Click Next. The Initial Level Images window will appear.
3. Toadd alevel image, click Add.
4. Browse to the location and select the desired image.

« Inthe Level Properties tab, enter the following information.

Name. Name level image (Optional).

Description. Give the level name a description
(Optional).

Background Color. Set a background color
(Optional).

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide

@ Create New Project [EERS)
3 New Project
.-1_]\, Please enter a project name and select a target location folder.
Project Name
Project Location C:\Users\cgera\Desktop\VES Y. atiview),
Project Description
Title Prefix
Scene size width ] 1920 ()] Height [ 1280 (@)
Default background color l:‘
Back Next Finish
@ Create New Project PR X
Initial Level Images
A
= | Please add any initial project level images
Level Images
Level Properties | Background Pasition
I i)
I Name
I Description
I Background Image
i Background Color 0
|
I
il
Version 1.00 | May 2020 | MAN-1443COM
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- Inthe Background Position tab, enter the following information:

Creating a New Project

« Check Center background to center the image to
the scene (Optional).

o Check Scale to fit to uniform scale the image to Level mages
the scene (Optional).

« Click and drag in the preview pane to manually
adjust the image position within the scene.

NOTE Furtherinformation on image positioning
can be found in the following section.

5. Add more levels as required. To remove the level, select the desired level and click Remove.

6. Click Finish when done.

VES Fire Detection Systems Version 1.00 |
L@ti-View Installation and Configuration Guide

(@ Create New Project (B
Initial Level Images
B Fiease add any initial project level images
[Levelpropertes | BackgoundPasiton |
|
Center background Seale to fit
Back Next Cancel
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Project Levels

Levels can be attributed to floor levels in a building, rooms, areas, or zones, and can be configured to lead to
other targets with the aid of hotspots, macros, etc.

Levels can be assigned, unassigned, promoted, demoted, and assigned as the Home page by editing the Project
Navigator Panel’s Sidebar tab.

To Add a Level Image

1. Inthe Project Navigator Panel, select the Levels tab and click Add. The Import Levels window appears.

Import Levels l Pl X

Level Images
Level Properties Background Position

D

MName
Description
Background Image

Background Color D

() Add || @ Remove

=

2. Click Add and navigate to the folder with the desired site images.

3. Double-click the desired image. It will be imported into the project and the options of having it centered and/or full-
scale or scale to fit. Batch import by using Shift+Click to select images. Edit the preferences for each level if
desired.

4. Add any remaining levels as desired. Click OK when finished.

5. Click Save or Save Version to save the changes.
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Organizing Levels via the Sidebar
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The Sidebar Tab contains two columns - Unassigned Project Navigator Panel 8 x
Levels and Sidebar Levels. The levels are displayed in s, [ b [ R Ot | € St
alpha-numerical order when imported. However, usingthe | 7=o=t== Saebarieves
. Level 0-5 - Level +3
left/right, up/down arrows, levels can be rearranged. Warning - Level0 T | Level 2
Warning - Level 1 ‘E Level
Levels moved to the sidebar can be arranged as necessary | | ferns et o N ety
by selecting the level and using the up/down arrows. The Vering - Level3 Level 2
level at the top becomes the Home level and, in the Levels ZONE 002
tab, will be depicted with a house icon. ZONE 003 (LEVEL o]
ZOMNE 003 [LEVEL -1]
ZONE 003 [LEVEL -2]
ZOMNE 004 [LEVEL +1]
FOME 004 [LEVEL 0]
ZOMNE 004 [LEVEL -1]
ZOME 004 [LEVEL -2]
ZONE 005
ZOME 006 [LEVEL -1]
ZONE 006 TLEVEL -21 S
EIEY (a)v]
Edit Level Properties
To edit the properties of a level, select the desired Level ([ edit properties =)

from the Levels tab in the Project Navigator Panel and click
the Level Properties button.

Remove a Level

Level Properties Background Position

D level_+3
Mame Level +3
Description

Background Image Level +3.png

Badkground Color I:‘

o OK ” # Cancel l

To remove a level, select the desired level from the Levels tab in the Project Navigator Panel Levels tab and click

Remove.
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Fire Alarm Devices

Once the configuration data has been imported from LE2, fire alarm devices can be assigned to project levels.
From the Project Navigator Panel, select the Object Model tab. The example below shows a typical
configuration:

Project Mavigator Panel =
| Levels | .3} Symbols | 1% Object Model | Sidebar |
Select subsystem ’ &y Fire VI
o:: Object Tree | -7 Equipment List I &) PA Zones |
| Q search |
Path Value Lot
ER C L
B9
box)la
&
- ££ Adapter Status Online
- 22 Driver Simulator
By status Maormal
- By status Maormal
=57 Panels
= [ Node 01
~ 22 Description MNew Site
- 22 FASID Nede 01
252 Loops
. Loop 01
Mot Applicable
Loop 01 b
Loopl
: -':j" status Mermal
#- 7 Loop 02
-2 Panell0
B status Mormal -
4| | r
[Hide placed items“Show all items] [Find unmatched placed items]

Sub-menus provide the following information:
Displays the fire alarm system based on the imported configuration in a tree format.

Object Tree « Click + to expand each entity, ultimately displaying individual properties.
« Click -to collapse the expansion.

Displays the fire alarm system based on the configuration in a list format.

Equipment List « Click Name to sort entities by name, in alphanumerical order.
« Click Location to sort entities by location, in alphanumerical order.
PA Zone Displays any public address entities forming part of the fire alarm system.

Search for entities in each subsystem using key words using the Find unmatched placed items button.
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Assig_jn Devices to Locations

IMPORTANT! To assign devices to their exact location in the building, it is recommended that blueprints produced
by the fire systems company, detailing the fire system, are used. These drawings will ensure devices are placed in
the correct locations.

Ele View Tools Help

&> ER e =t Norma Operaton
Level +3
@ =»ax
» B . = ;e e . = S
g"  MamConfg EocEdBER 8 4§HB 2¢ Hduaa =8 g @ u & == T EmQQm %y EBE
& MamStatus
B 3
B Adiig o B
Yy Fre ]
e | ) e
& Fire Configuration A T
@ werkstaton Config u by
_______ i
o = !
' '
'y | ! M
r ! !
i 4 ' I
I
v ]
) '
el I !
. ) !
i ) |
) ' !
I AUTO CONFIG..
- ! N Nede0l
[
' '
| ! W
) 1
) '
) 1
Properties Panel & X
ebase | ®Appearance | o Fiags | .\ woubles
JPCPath L@ti-View.Fire Panels.Node 01.Loops.Panel10. Devices.PanelIO Device
Name Panello Device
Desaipton
|| Locaton
Contains Path
| N N7 7
L) RSLEE | L B B =
= < [ i B Properties Panel | Fifter Items Panel
[pater vode Zoom: 370% Unsaved changes

Logged on as:Administrator Workstation ID:box01a Online 28/06/2019 10:25

From the Object Model, Equipment List, and PA Zones tabs, drag and drop fire alarm devices to their
corresponding Level locations. Detailed information about the device is displayed in the Properties Panel.
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Symbols

L@ti-View uses symbols to represent a selection of commonly used fire alarm panels, detectors, and associated
devices. Drag and drop symbols on levels to replicate the fire alarm system. These symbols are automatically
imported with the project configuration.

Other library symbols can be imported within L@ti-View. Symbols can be created and imported from outside of
L@ti-View, provided they meet the criteria outlined later in this section.

To add a Symbol to a Level

1. From the Levels tab, select the level where symbols are to be added.

2. Click the Symbols tab and select the desired symbol.

3. Drag the symbol to the desired location on the level. From there, the properties can be edited, and it can be moved
and resized. Using the Properties panel, symbols can be further configured by the user.
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Hotspots

Hotspots are designated locations that link to a specified area when clicked.
Hotspots can be bordered or invisible. The cursor changes to a clickable
hand cursor when hovering over them and a tooltip appears with the linked
location.Hotspots can only be created or edited in Editor mode.

Creating a Hotspot

Stroke Style __Solid - = Fill Style _:ross -
1. From Editor mode, centralize the desired Hotspot area. : = =
2. Select the Hotspot icon (circled below) and draw the , ]
4 o
| I | . Ii]

outline for the desired hotspot, clicking at each comer,
joining the first and last points. The completed hotspot
will be filled in, as selected in the Hotspot menu bar. The
shape fill does not display in Control mode, and the
outline can be tumed off using Stroke Style.

NOTE The scroll bar can be used during hotspot creation
when desired plot points are off-screen. To cancel an
incomplete hotspot, press Esc. To delete a hotspot, select
it and press Delete.

mm@fﬂ\ybr_Lm
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3. When the hotspot is complete, click the Select icon and
select the hotspot.

4. Select the Base tab of the Properties tab. Select the
desired Target.

5. Click Save or Save Version.
6. Test the Hotspot in Control mode.
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Properties Panel g x
.7 Base *. Appearance | | Flags | ', troubles
JPC Path
MName Plotted Hotspot 7
Description
Location
Contains Path
Target zone_001 T
site_plan o
warning_-_level_-1 —
warning_-_level_0 |J
warning_-_level_1
- warning_-_level_2 B
|| Properties Pan warnini - level 3
zone_002
zone_003_[level_+1] =
zone_003_[level_-1] &7
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Shapes and Lines

Shapes and lines can be added to the current level, and various attributes (colors, fill, borders) can be changed,
depending on the shape.

Grouping and Transforming Shape Tools

Two shapes can be grouped or changed using these tools.

s L B
Tool Description
Minus Back Subtracts the objects in back from the front-most object.
Minus Front The front-most objects will be cut out from the back-most object.
Removes the part of a filled object that is hidden. Removes any strokes and merges any adjoining or
Merge . . ) .
overlapping objects filled with the same color.
Intersection Traces the outline of the region overlapped by all the objects.
BASIC SHAPES MINUS FRONT MINUS BACK MERGE INTERSECTION
Zones

Zones are irregular polygons drawn to surround specific areas or levels, and they can be color coordinated and
allocated to one of the following types:

« Detection Zones
« Evacuation Zones
« Operational Zones
o PA Zones

Zones can overlap, be duplicated on split levels, and can be filtered by type.
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Click the Grid icon, which turns on the 10x10 grid overlay.
Select the desired level for the zone.

Click the Zone icon and select a zone type from the zone
drop-down menu.

Draw the desired shape for the zone, ensuring that the first

point and last point connect. This is confirmed when the
shape's shading turns solid.
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Project Navigator Panel
| [ Levels | | Symbols | %] Object Model |

Sidebar |

Select subsystem ’ ¥y Fire

7)
|

= Object Tree | ¢ Equipment List | ") PA Zones |

|"u"a|ue

| Location ;I

[_j:

nes

.i\

Sl
=]

NOTE Hold down Shift while drawing to create lines in 45°
angles.

-]

[

Detection Zones
& DetZone0001

iy

L3

ghe.. Enabled
DetZone0001

When the zone is complete, click the Select icon and select
the zone.

Select the Base tab of the Properties tab.

Select the Object Model tab of the Project Navigator
Panel, with the subsystem Fire.

Select the zone to allocate and drag it to the Properties panel
of the newly-created zone to auto-fill the relevant fields.
Click Save or Save Version.

Detection Zonel
Evacuatien Zon..

w Null
Mormal

Zone2 T
| »

[Find unmatched placed items]

|

F i
’Hide placed items”Sh* all items]
J

Properties Panel [

o Baze

g x

arance | .@TFIags | ATroubIes|

JPC Path L @ti-View.Fire.Zones.Detection Zones.DetZoned001

NOTE Two or more zones given the same Object Model
details will be treated as the same zone for alert purposes.

Mame Detection Zone 1
Description

Location Zone 1

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide

Contains Path

Properties Panel Filter Items Panel
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Text

Text can be added and edited like other objects in L@ti-View.

1. Toaddtext, click the Text icon and set the font attributes and the desired background.
2. Click the location on the screen and enter the desired text. Text boxes can be relocated using the Select icon.

NOTE Text can be edited in the Appearance tab of the Properties Panel. Press Enter to apply the changes. Use the
box handles to resize the box to fit the new text if required.

3. Click Save or Save Version.
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Flags

Zones and Symbols can display an alert flag generated by one or more external sources. The displayed flag is
always the highest priority alert if several input sources send alerts.

Alert flags are allocated a higher z-index than symbols and zones and always appear on top of the display. Alert
flags can also be given a positional offset from their nominal position (center point) so that conflicts between
adjacent symbols can be easily resolved. Alert flags pulse on priority-state transitions, the duration of which is
configurable.

A project’s flags, properties, and settings can be customized in the Edit Project Setting screen of the 2D GUI
Editor. The default alert flags are:

= Unknown - Information
O i J

Warning ~  Reduced Service
Q) |

Alarm Priority Alarm

?| Critical 3 Alarm (Pre-Fire) Fl Critical 2 Alarm (Fire)
o Critical 1 Alarm c

Auxiliary Alarm 2 Implicit (Disablement)
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Navigation buttons can be added that allow L@ti-View to link to other levels within a project. The navigation

buttons can be assigned the following properties:

« Main button text (mandatory)
« Description text (optional)

« Target page (mandatory)

« Font name (mandatory)

« Font base size (mandatory)
« Icon (optional)

« Accessory icon (optional)

MAIN BUTTON TEXT

ICON ACCESSORY ICON
‘ LEVEL 4
-...:;Il Parking ’

DESCRIPTION

Font M5 Shell Dig 2

v Size: 8Pt | @ Icon

Mo Icon

0 0

@ accept.png
arrow_down.png

(& arrow_redo.png

'f::'g arrow_refresh.png

=¥ arrow_right.png

'.5_5‘ arrow_rotate.. lockwise.png

'@‘ arrow_rotate_dockwise.png

58 arrow_switch.png

| arrow_turn_left.png

1. Click the Button icon and select the desired location for the button.

2. Click the Select icon and click the button to edit. Drag it to a new location, resize the button, or change any desired
attributes.

3. Enterthe button properties in the Base tab of the Properties panel. Select a Target for the button, and, optionally,
enter a description which will appear as the subtitle on the button. Press Enter to apply the changes.

4. Inthe Appearance tab, enter the button's main description in Text field and press Enter to apply the changes.

Accessory Icon | 2 right_arrow_alpha.png -
ﬁ lock.png -
=4 lorry.png
map.png

|22 map_go.png

photo.prig
| picture.png
& pictures.png T
= report.png [

right_arrow_alpha.png
LI script.ong

NOTE Buttons must always be in the front of all other objects to be functional.
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5. Click Save or Save Version.

6. Test the Button in Control mode.

Macro Buttons
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Adding Macro buttons is the same procedure as adding Navigation buttons, however a Function is selected
rather than a Target, and there are no icons or subtitles.

The following Macro functions are available:

Show Schematic
Fire: Create maintenance log
Fire: Close Contact
Fire: Enable Device
Fire: Disable Device
Fire: Disable Zone
Fire: Enable Zone

Fire: Evacuate Zone

VES Fire Detection Systems

Fire: Open Contact
Fire: Reset Panel
Fire: Silence Buzzer
Fire: Silence Panel
Fire: Show In Status Tree
Fire: Show In Maintenance Page
Fire: Show Operational Procedures

Fire: Start Zone Test

L@ti-View Installation and Configuration Guide

Fire: Start Find Mode
Fire: Start Poll
Fire: Simulate Fire
Fire: Stop Find Mode
Fire: Stop Poll
Fire: Stop Zone Test
Workstation: Suppress Audible Alerts
CCTV/PIS: (TBC)
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SAVING, EXPORTING, AND RESTORING PROJECTS
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Saving a Project

Projects should be saved regularly. To save the entire project with the same project name,

1. Click Save Project.
2. Enter any desired details (optional).

L ™
@ Save Project M

Please enter details of the changes.

| ok || % cancel |

3. Click OK.

NOTE The Change Log can be viewed using Edit Project Settings.
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Saving a Project Version

Saving time-stamped project versions allows the user to reopen and save an earlier version. It is recommended
to save the current project as a project version before making any changes to it. To save a version,

1. Click Save Project Version.
2. Enter any desired details (optional).

© ™
@ Save Project Version m

Please enter details of the changes.

[ o OK ][ 9 Cancel ]

W "y

3. Click OK. The project version is time-stamped and saved to the project folder under Versions.

NOTE To view previous saved project versions, click Restore Project Version.
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Exporting a Project

To export a project to a new location, e.g. to a server, FTP site, or to cloud storage,

1. Load the project or version to export.

2. Click Export Project.
3. Select the desired destination click Select Folder.The project will been saved (with the same file name) to the des-

tination folder.
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Restoring a Project Version

L@ti-View starts up using the last saved configuration. If the screen canvas is blank, or if there is an error or
omission, either restoring a project version or load an existing project. To restore a project version,

1. From Editor mode, click Restore project version.
2. Navigate to the desired saved project and click Select Folder.
3. Click Yes to replace the current version. This will load a working copy of the project.

NOTE Restored versions should be thoroughly reviewed before saving.
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SYSTEM CONFIGURATION MENU

The left side of the L@ti-View screen contains a user-dependent configuration menu. The following shows the
buttons allowed for a full access user.

@ 20 GUI

i ] Alarm Config

Alarm Status
Lai] Archiving
& Fire
@'Account Management

¥y Fire Configuration

(&) Workstation Config

Version 1.00 | May 2020 | MAN-1443COM
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2D GUI

Refer to 2D GU| Editor Mode for complete information about this option.
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Alarm Config opens the alarm configuration table, where the alarms can be created, copied, deleted, and

filtered.

File View Tools Help

b B MNormal Operation
@ o Alarm Configuration
% Aamconfig || Alarm Configuration Table

Alarm Configuration
5 Aamstatus
IPCPath escription Suggested Action ScriptID Acknowledge Rec Priority
# Archiving
& Fre
£Account Management

¢ Fire Configuration

(@ Workstation Config

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide

Version 1.00 |
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Alarm Status

The Alarm Status tab provides access to the following views:

o Alarm List

« Alarm Event History

« System Event Log

« Additional Alarm Information
« Suppressed Alarms Table

Alarm List

The Alarm List is the default view when selecting the Alarm Status tab. This view displays filtered results using
buttons, drop-down menus, and column headers.

Fle View Tools Help

& EH @ Normal Operation
®  wex System Alarm Status

= (&) Alarm EventHistory () System Eventlog (@ Additional Alarm Information || Suppressed Alarms Table:

# Harm Config

Alarm List
Eamiiznazis Pricrity Filter e
B Archiving acknowledge |[Unacmonledge) [ Clear AL =] A
Fire
=

2, - L@ti-View
£ Account Management PAVA

& Fire Configuration Subsystem Equipment Alert

@ Workstation Config

5/21/2020 3:25:16 PM Fire Adapter 1 Trouble
5/21/2020 3:25:16 PM Fire Node 01 Trouble

Fiter Coa: E— e —

Alerm View Summery: Total: 7, Unacknowledged: 7 |

Logged on as: Administrator. Workstation ID: box01a Onine 5/21/2020 4:08:00 Pl
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This button opens a page that organizes and filters the Alarm Event History using column sorting, drop-down
menus, and various filters.

File View Tools Help

& R e

@ D6

#  Aam Config

Alarm Status
B Ahiving

@& Fre
£Account Management

& FreConfiguration

(@ Workstation Config

Normal Operation

System Alarm Status

© Alarmist (@ SystemEventiog @ Additional Alarm Information || Suppressed Alarms Table:
Alarm Event History
Time Fiter Subsystem Fiter
@ Lasthour ALL
Last 24hours [Et .
) Betwesn 2/21/2020 and 5/21/2020 pA\/‘A “
Time Alarm 1d Event By Subsystem Equipment Alert -
5/21/2020 3:25:16 PM 30 CREATE SYSTEM Fire Adapter 1 Fire
5/21/2020 3:2516 PM 29 CREATE  SYSTEM Fire Adapter Disablement =
5/21/2020 3:25:16 PM 28 CREATE SYSTEM Fire Adapter 1 Supervisory L
5/21/2020 3:2516 PM 27 CREATE  SYSTEM Fire Adapter Carbon Monaside
5/21/2020 3:2516 PM 25 CREATE  SYSTEM Fire Node 01 Info
5/21/2020 3:25:16 PM 25 CREATE SYSTEM Fire Adapter 1 Trouble
5/21/2020 3:2516 PM 24 CREATE  SYSTEM Fire Node 01 Trouble
5/21/2020 3:25:16 PM 19 CLEAR SYSTEM Fire Node 01 Info
5/21/2020 3:2516 PM 17 CLEAR  SYSTEM Fire Node 01 Trouble
5/21/2020 3:25:16 PM 21 CLEAR SYSTEM Fire Adapter 1 Supervisory
5/21/2020 3:2516 PM 23 CLEAR  SYSTEM Fire Adapter 1 Fire
5/21/2020 3:2516 PM 18 CLEAR  SYSTEM Fire Adapter 1 Trouble
5/21/2020 3:25:16 PM 20 CLEAR SYSTEM Fire Adapter 1 Carbon Monoxide p
Filter Column ilter pattern: 7] Case sensitve
Alarm List
Alarm Priority ubsystem Filter
acknowledge | Clear (= = [A -] (A
Fire
Leti-View
PAVA

Subsystem Equipment Alert Description Ack Time

@ Trouble
@ Trouble
]

Adapter 1
Node 01

Trouble
Trouble

Ack'd By

Fiter Colam: E—

[7] Case sensitive |Fixed string -

(Alarm View Summary: Total: 7, Unacknowledged: 7

VES Fire Detection Systems
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This organizes and filters the System Event Log using column sorting, drop-down menus, and various filters.

Ele View Tools Help

&R 8
@ »au
/~  Alarm Config
Alarm Status
B Archiving
& Fre
£ Account Management

& Fire Configuration

(@ Workstation Config

Mormal Operation

(&) Alarmlist () Alarm Event History (@ Additional Alarm Information || Suppressed Alarms Table:

System EventLog
Time Fifter

System Alarm Status

asthour

Last 24hours

etnesn 2/21/2020 and 5/21/2020
Mo Time Type Tet Date =
38 5/20/2020 3:17:40 PM information Login Successful logi.
37 5/20/2020 3:17:30 P nformation  Config file error  Config:zoadCo L
36 5/20/2020 3:17:30 PS No XML found 1
3 5/19/2020 T:41:21 AM EVENT ClearAlarm o targetsetfo b
34 5/18/2020 9:28:53 PM information Logout Successful logo.
E 5/18/2020 9:28:47 PM EVENT Commit Alrm .. N target st o
32 5/4/2020 3:47:25 AM Information Raised EventID: '20". P.
31 5/4/2020 3:47:25 AM Information Raised EventID: 0. Pa.
30 5/18/2020 1:55:53 PM information  Login Successfillogi
29 5/18/2020 1:55:46 PM information Login Failed login for
2 5/18/20201:55:35 PM information  Config file error  Configizoado
27 5/18/2020 1:55:35 PM Serious. No XML found
2% 5/5/202010:59:33 AM information  Logout Successfillogo. il
Filter Column Eier pattern: [7] Case sensitve
Alarm List
Alarm Priority Subsystem Fiter
Adaowledge | L Clear (=R m =] (AL
Fire
L@t-View
PAvA

Subsystem Equipment  Alert Description Ack Time

5/21/2020 3:25:16 PM Fire
5/21/2020 3:25:16 PM Fire

Trouble
Trouble

Ack'd By

Fiter Column: ier patter:

[7] Case sensitive [Fixed string -

(Alarm View Summary: Total: 7, Unacknonledged: 7
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The Additional Alarm Information tab organizes and filters additional alarm information using column sorting,
drop-down menus, and various filters.

File View Tools Help

& R e

@ D6

Normal Operation
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#  Aam Config

5 MamStatus
B Ahiving

@& Fre
£Account Management

& FreConfiguration

(@ Workstation Config

() Alarmust () Mlarm Eventistory () System EventLog [ () Additonal Alarm Information

Additional Alarm Information

2] Suppressed Alarms Table:

System Alarm Status

Alarm List
Alarm Priority Subsystem Filter
Adaowledge | L Clear (=R m =] (AL
Fire
L@t-View
PAvA
Equipment  Alert

5/21/2020 3:25:16 PM Fire
5/21/2020 3:25:16 PM Fire

dter Cotars [~ sl pottrn

Alar

m View Summary: Total: 7, Unacknowledged: 7

[7] Case sensitive |Fixed string -
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Suppressed Alarms Table

The Suppressed Alarms Table tab organizes and filters the suppressed alarms table information (if any) using
column sorting, drop-down menus, and various filters.

File View Tools Help

& F & Norml Operation
@ pYetid System Alarm Status
#  Aam Config

() lamist () Alarm Eventistory () System EventLog @ Additonsl Alarm Information (1] Suppressed Alarms Table
Suppressed Alarms Table
5 MamStatus

JPC Path Description User Name Reason Priority Expiry Time  Manually Suppres
1% Achving
& Fre
£Account Management
& FreConfiguration
(@ Workstation Config
Alarm List
Alarm Priority Subsystem Fiter
[Adknoiedge | [ cear | [o= =]ar =] (AL
Fire
L@t-View
PAvA
Priority Time Subsystem  Equipment  Alert Description  AckTime  Ack'd By

5/21/2020 3:25:16 PM Fire Adapter 1 Disablement

5/21/2020 3:25:16 PM Fire
5/21/2020 3:25:16 PM Fire

dter Cotars [~ sl pottrn

|Alarm View Summary: Total: 7, Unacknowledged: 7

Logged on as: Administrator Workstation ID: box01a Orline. 5/21/2020 3:34:00 PM
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Archiving

FIRE

The Archiving tab allows the user to view, create, copy, and delete a Database Archiver Configuration. L@ti-
View will automatically convert any frequency over 24 hours to days and hours.

File View Tools Help

DETECTION
SYSTEMS @ g ®

& @ & Normal Operation

@ EYert Database Archiver Configuration

7 Aam Config

© MamStatus

Frequency Youngest Record Source Table Time Column Delete Archived

£y divig 24h0m0s 91di6h0mids eventlog time

& Fre 24h0m:0s 9Ldk6h0m:0s, alarmlog createtime
Account Management 2h0mis 91d6h0m:0: time

& Fire Configuration

(@ workstation Config

J
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Fire

The Fire tab provides access to the following:

« Fire System
« Maintenance
« Event History
« FAS Topology
o Alarm List

o Status Tree

NOTE The Fire tab defaults to the Alarm List upon opening and synchronizes every 10 seconds.

Fire System

On the Fire System page, report styles can be selected, acknowledged, and printed. There is also a visual
representation of the selected zone, with options to move or resize, and the ability to move up, down, left or right
to see different evacuation zones.

File View Tools Help

@ o8 Normal Operation
@ = FIRE GUI
(@ Fresystem] /" Mantenance () EventHistory = FASTopology (3 Alarmlist = Status Tree
£ pam Config FreSysten] =2 Y pology () =
© Aemsts
L5 Archiving
o < & Actve Fire Alarms
& Fire
Actioned Inv Time Time Device EVZone Type
£ Account Management X 0000:00  5/21/2020 10:13:17 AM Carbon Monoxide
& Frccon 3000000 5/21/2020 10:18:05 AM Fire
(@ Workstation Config
b Device Status: =
Q
MName Vall
[eﬁ AdmuwledgEl li Sience Navmsl IQ Rese(?ana\l l ManualEva(]
‘Alavm View Summary: Total: 7, Unacknowledged: 7 Fire | 1 | Trouble | 2 | Disablement 1 |Test 0
Logged on as: Administrator Workstation ID: box01a Online. 5/21/2020 3:58:00 PM
Maintenance

The Maintenance tab displays all of the nodes in the configuration. Selecting a node from the list will populate the
Equipment list on the bottom of the screen. Upon selecting a device, the following options are available:

« Enable selected device
« Disable selected device
« Start polling a selected device

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
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Stop polling a selected device
Operate selected equipment
Restore selected equipment

FIRE otCe
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Selecting at least one item from the Equipment list enables the Enable / Disable buttons or allows the user to
manually create a Maintenance Log entry.

When selecting any of the above options, a window will appear requesting a reason why the action has been

done.

At least one character must be entered to proceed.

Ele View Tools Help

@ IF &

@® >

42 Marm Config

©  AamStats

Normal Operation

FIRE GUIL
& Fresrsen 3 vt it

Y 4 FAsTopoogy () Alamist = StausTree

] (G Aiverens) [ rommaetan)

Select Equipment Type:

[

Information

-]

[9] Select Panels

Q sea Quick Filter:  Loop =

Select Equpment  Enable |5 Disable ?)(@)([@] -

~ [ advancedriter] | ¥ clear

FASID. Name ~ Type Description  Parentltem  Panel Loop Enablement Stat

Loop 0L Loopl Loop [No Data] FireNET L@titude 0 Not Applicable
Loop 02 Loop2 Loop [No Data] FireNET L@titude 0 Not Applicable

[No Data] FireNET L@titude 0 Enabled

Enabled
FASID Panell0
Name Panel /O
Status Normal

|Narm View Summary: Total: 7, Unacknowledged: 7

e 1 o[ 2 | owmbenen [ 1 e[ 0] |

Maintenance Log

To create a manual maintenance log entry,

1.
2.

From the Fire tab, select Maintenance > Maintenance Log.
Click New at the bottom (or right-click and select New...). The
Creator window will appear.

Add/ edit the log entry. The time and date defaults to the local
system time, but this can be changed. Check the box to Keep
the dialog open to create additional entries if desired.

Click Create when finished.

Logged on as: Administrator Workstation ID: box01a Online 5/21/2020 4:01:00 PM

NOTE Asset Codes cannot be added when creating an entry,
but can be edited later by double-clicking the desired entry and
making any needed changes.

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide

rJ Creator M‘
@ @
Time o1jo/2020 [5] [ 12 : 00
2
Short Description
Detail
Asset Codes
External Ref
User
[T keep dizlog open Create ] [ Cancel
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To export a maintenance log file to a .csv file (which can be opened in Microsoft Excel or Google Sheets),

Hpobd =

Click Save.

FIRE RN

SYSTEMS @ g ®

From the Fire tab, select Maintenance > Maintenance Log.
Click Export at the bottom (or right-click and select Export...).
Enter a file name and select a location.

To create a maintenance log report,

1. From the Fire tab, select Maintenance > Maintenance Log.

2. Click Report at the bottom.

Gy Print Preview

Report Print Preview

Settings

Time 25/05/2020 17:14

Author Administrator

Tite FAS Active Events

Description

Notes

Tide: FAS Active Events

Fe@l=c 2a8(aals

Rows perpoge ———— [+ | () ()

Page 10f 3 [ Generate Report

3. Enterthe report details and use the icons to change the layout as desired.

4. Click Generate Report.

Active Events

From the Fire tab, select Maintenance > Active Events. Active events can be filtered by specific event type,

Quick Filter, or Advanced Filter.

VES Fire Detection Systems
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Ele View Tools Help

Normal Operation

FIRE otCe
DETECTION
SYSTEMS @ ¢ ®

& EH o

@ mou

® Marm Config
Alarm Status

B Ahiving

& Fire

£Account Management.

& Fre Confiuration

@ Workstation Config

& Feesten ettty S Topobgy (9 Ammlst = SisusTes

FIRE GUT

[P (Cdnas) [Pt

Active Panel Events:

Seectcvent ype: (A1 J[a=

| quickiters toop = - = cex

Active Events

5/25/2020 12:11:20 PM Inforr
5/25/2020 12:09:07 PM Super

5/25/2020 12:08:50 PM Carbor
5/25/2020 12:08:45 PM Fire
5/21/2020 10:19:30 A... Trouble
5/21/202010:19:29 A.. Disable... =
5/21/202010:19:29 A... Informa.. Raise ireNET L@titude

SYSTEM
SYSTEM
SYSTEM
SYSTEM
SYSTEM
SYSTEM
SYSTEM

EVENT
EVENT
EVENT
EVENT
EVENT
EVENT

Value
User Logged In
7205759408310,

e [+ [t | + | csrers | 1 7t [ 0] |

Event History

Logged on as: Administrator Workstation ID: box01a Orline 5/25/2020 5:13:00 PM

The Event History page shows all historic events with additional information (if available). The history can also be
used to create reports or exported as a .csv file.

The Event History can be very long and detailed, so authorized users can view and/or rearrange it by:

« quick filter (e.g., Loop)
« clicking column headings
« changing time/date periods

« choosing event type and sub-type

« using an Advanced Filter tool (i.e., drop-down menus for Columns + Operands + Data)

VES Fire Detection Systems
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File View Tools Help

& EHm Normal Operation
@ =»an FIRE GUI
B plarmcont & Fire System  J” Maintenance [ |- EventHistory | -+ FASTopology () AlarmList = Status Tree
/am Config
- AamStatus Filter Event data: Filter time period
5 Achiving Select event type: (Al -] Last Hour
& = Sub type: [ -] Last 24Hours

£ Account anagement QuekFiter: Loop = - * Gesr | (© BetweenFriFeb 212020 and Thu May 21 2020

& Fire Configuration

@ workstaton Config Historic events Information

Q Q

EventlD  Type  SubType  Time Panel Device  Zone  ActionedBy  Reason Fire Adapter Vendor Info Value

% Carbon . Raised 5/21/2020 1019:17 AM Fire.Panels.Pancll0 SYSTEM EVENT Fire Adapters. Adapter 1 Card 0

27 Disable. Raised 5/21/2020 10:19:28 AM Fire.Panels.Panell0 SYSTEM EVENT Fire.Adapters.Adapter 1 Description Mo Event
Fire Adapters.Adapter 1 Input 8

18 Informa... Raised 5/4/2020 7:45:14 AM SYSTEM EVENT Fire Adapters.Adapter 1 Locak-id 5767422738073,

17 Informa... Cleared 5/4/2020 T:45:14 AM  FireNET L@titude SVSTEM EVENT Fire.Adapters. Adapter 1 Panel 1

18 Informa.. Cleared 5/4/2020TAT2A AM  FireNET L@fitude SYSTEM EVENT Fire Adapters.Adapter 1

20 Informa... Raised 5/4/2020 T:47:25 AM  FireNET L@titude SYSTEM EVENT Fire.Adapters. Adapter 1

o Informa.. Raised 5/4/20207AT25 AM  FireNET L@fitude SYSTEM EVENT Fire Adapters.Adapter 1

17 Informa... Raised 5/4/2020 7:47:25 AM  FireNET L@titude SYSTEM EVENT Fire.Adapters.Adapter 1

19 Informa.. Raised 5/4/202074T25 A FireNET L@fitude SYSTEM EVENT Fire Adapters. Adapter 1

22 Informa.. Raised 5/21/2020 10:20:06 AM FireNET L @titude SYSTEM EVENT Fire Adapters. Adapter 1

23 Informa... Raised 5/21/2020 10:20:25 AM FireNET L@titude SVSTEM EVENT Fire.Adapters. Adapter 1

2 Informa... Cleared 5/21/2020 10:22:11 AM FireNET L@titude SYSTEM EVENT Fire Adapters. Adapter 1

EX] Informa... Raised 5/21/202010:22:12 AM FireNET L@titude SYSTEM EVENT Fire.Adapters.Adapter 1

3 Informa.. Raised 5/21/202010:2513 AM FireNET L@titude SYSTEM EVENT Fire Adapters,Adapter 1

24 Informa... Cleared 5/21/2020 10:25:13 AM FireNET L@titude SYSTEM EVENT Fire.Adapters.Adapter 1

E3 Inferma.. Raised 5/21/202010:25:16 AM FireNET L@fitude SYSTEM EVENT Fire Adapters. Adapter 1

35 Informa... Cleared 5/21/2020 10:25:16 AM FireNET L@titude SYSTEM EVENT Fire.Adapters.Adapter 1

% Supervis... Raised 5/21/202010:19:08 AM Fire.Panels.Panell0 SVSTEM EVENT Fire Adapters, Adapter 1

2 Trouble  Raised 5/21/202010:13:06 AM Fire.Panels PancllO SYSTEM EVENT Fire Adapters Adapter 1

21 Trouble  Raised 5/21/2020 10:19:30 AM FireNET L@titude SVSTEM EVENT Fire.Adapters. Adapter 1

|Alarm View Summary: Total: 7, Unacknowledged: 7 Fire | 1 | Trouble | 2 | Dissblement | 1 | Test | 0

Logged on as: Administrator Warkstation ID: box01a Orline 5/21/2020 4:04:00 PM

L@ti-View reports allow both simple and advanced searches to narrow down a specific data type or series.
Advanced filtering can use column headings with boolean expressions plus free-text data:

« =equalto

« !=notequal to

« > greaterthan

« >= greater than or equal to
e <lessthan

o <=less than orequal to

o Like...

Only one filter term can be used.

EXAMPLE [Zone = 2] would show only events that are listed for Zone 2, whereas [Zone != 2] would show all
events except those in Zone 2.

Fire Alarm System (FAS) Topology

The FAS Topology page lists all connected devices and shows their current Status and Operational Status. The
classes can be expanded or condensed by clicking the + or - icons.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
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Normal Operation

FIRE o0
DETECTION
SYSTEMS @ ¢ ®

@ »ar

FIRE GUI
/  alam Config

& Fire System  J” Maintenance [ EventHistory [ [ FAS Topology | (&) Alarm List

Fire System Topology

= Status Tree

¢ AamStatus

[ status [ Enablement status

[pescription
Y

Normal Enabled

\Alarm View Summary: Total: 7, Unacknowledged: 7

Fire Trousle Disablement Test| o | ‘

Alarm List

Logged on as: Administrator Workstation ID: box01a Orline. 5/21/2020 4:06:00 PM

The Alarm List page opens a list of all the alarm events, with an itemized summary of alarm types at the bottom of

the screen.

Fle View Tools Help

b @B o & MNormal Operation
@ = FIRE GUI
Jy Fire System  J Maintenance EventHistory - FAS Topol = Status Tree
[ — & Fire sy P = ¥ pology [ lerm List] =
Alarm List
SRR Alarm A Priority Fiter
B Ahiving ( Acknowledge ] Unacknowledge [ e [z= v A -
& Fire Priority Time. Description  AckTime  Ack'd By
£iAccount Management ®

¢ Fre Configuaton

(@ Workstation Config

@
@ Disablement
®

5/21/2020 3:25:16 PM Adapter 1

© Trouble
© Trouble

5/21/2020 3:25:16 PM Adapter 1
5/21/2020 3:25:16 PM_Node 01

\Alarm View Summary: Total: 7, Unacknowledged: 7

Fire Trousle Disablement Test| o | ‘

Status Tree

Logged on as: Administrator Workstation ID: box01a Orline 5/21/2020 4:07:00 PM

The Status Tree page opens an expandable tree layout of the network and attached devices. Use it to see the

current status and alert types of any listed item.

NOTE The values are controlled by the item type; some will return three values while others will return seven.

VES Fire Detection Systems
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Version 1.00 |

May 2020 |

MAN-1443COM
Page 81



File View Tools Help

FIRE

Normal Operation

DETECTION
SYSTEMS @ ¢ ®

System Configuration Menu

GELE .
@ »ax
/  alam Config
- MamStatus
#  Ahiing
& Fie
5 Account Management

& Fire Configuration

(@ workstation Config

FIRE GUI
@ FireSystem /" Maintenance () EventHistory - FAS Topalegy () Alarm List
Status Tree
Path [vaiue [ Last Upaate [ Location
= 5 Lati-View
=% Fire Carbon Monoxide
Activelnstance borila
Adapters Carbon Monaxide
% Adapterl Carbon Monaxide
Adapter Status Online
Driver Takis
alerts
B Auwiliary Normal
@ Carbon Monexide Carbon Menexide
- E] Cause and Effect Normal
- E] Comms Trouble Normal
- E] Config Mismatch Normal
@ Disablement Disablement
-~ © Fire Fire
& Implicit Disablement Normal
- E] Info Normal
B Offline Normal
- Ef Pre-Alam Normal
B Security Normal
@ Supervisory Supervisory
B Te Normal
© Trouble Trouble
© status Carbon Manaxide
o alets
- E] Comms Trouble Normal
E] status Normal
‘% Panels Trouble
% Node01 Trouble
Description New Site
FASID Node 01
5% Loops
Name FireNET L@titude
© alerts
© status Trouble
] status Normal
4 Zones
B status Normal
© status Carbon Monoxide

|Alarm View Summary: Total: 7, Unacknowledged: 7

Fire

Trouble Disablement

o]

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide
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The Account Management tab allows the management of all user accounts, permissions, and passwords.

Frames and columns are resizable to enable easier reading of long descriptions. For more information on
managing user accounts, refer to Accounts and Access.

Ele Yiew Tools Help

& Ean Normal Operation

@ D6 Account Management
— e

LR [Qses Name Admiristrator

B Archiving Username Description Full Name

& Fire Company

£ Account Management
¢ Fire Configuration

(@ workstation Config

[ tmport | [ E]Export | [ZRefresh | [ @add | [ & clone | [ @ Delete

Enabled
[Q seare | 7 show assignediitems only
Name [ Descriptior
E- Groups.
 Adminis.. User mitted to administer the system,
User em.
User
Ore

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide

Version 1.00 |
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Fire Configuration

The Fire Configuration tab has two tabs - Panel Comms and Fire Configuration.

Panel Comms

The Panel Comms page controls the panel, panel communication type (IP or Serial port), and it allows a
communication test.

| Eile | View Tools Help

@& B & dh Normal Operation
@ mou Fire Configuration Page
& Alarm Config

Alarm Status w Panel Comms

“ Set-up Connection to a Fire Panel
o Archiving [ Fire Configuration

- re Connect to panel
£ Account Management Panel Type: Hochiki Latitude (UL) <
¥ Fire Configuration

(@) Workstation Config IP Address: 192 168147121

Panel connectivity test

8 [ 0x00 ] I Connectivity established. ]

Fire Configuration

The Fire Configuration page allows a user to import a configuration file from LE2.

Fie View Tools Help
@ FEH Normal Operation

@ wmax Fire Configuration Page
£ Alarm Config
e @ Panel Comms §
3 Import Loop Explorer Configuration from a connected panel o file
Z Achiving Fire Configurati
Y e G Loop Explorer

§Account Management

Time Synchronization
@ Frre Configuration

@ Workstaton Config

Logged on as: Administrator Workstation ID: box01a Online 5/22/2020 11:33:00 AM
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Workstation Config

The Workstation Config tab allows authorized users to access many configuration options, as shown in the left-
hand menu below.

WARNING! Workstation configuration changes can have serious consequences that could affect the L@ti-View
system’s functionality or security.

To allow configuration recovery, export the current configuration or the entire project before making any
configuration changes.

WARNING! Due tothe potentially adverse consequences of experimenting with live systems, it is recommended
that Demonstration mode be enabled for training or project creation scenarios.

Always import or reload the Operational configuration or project when finished.

WARNING! Workstation configuration changes can be made in Control Mode or Editing Mode, so Operational
configuration changes should be restricted to specifically authorized persons only.

NOTE Configurations and projects are not the same thing. A typical configuration file export is about 12 Kb, while an
exported project folder holds many files.

Training and development projects can be exported, and then imported if they require further work. Although it is
not recommended, configuration files can be directly edited at the source using an appropriate text-only editing
tool.

General

Use this tab to add a site name to the project.

VES Fire Detection Systems Version 1.00 | May 2020 | MAN-1443COM
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File View Tools Help

& FL
@ DEU
P Marm Config
- MarmStatus
(5 Archiving
& Fire
£Account Management

& Fire Configuration
(@ Workstation Config

Normal Operation

Workstation Configuration

_ @ General options for L@ti-View

& Printing R
neral

& Site Name: | L@tView] ]

% Sound

& Monitors
L Alarms
@ Language
[ Event Log

« License

Logged on as: Administrator Workstation ID: box01a Cnine 5/22/2020 11:42:00 AM
i

Printing

Use this page to change or confirm the L@ti-View default print settings. The printer drop-down menu shows the
printers already installed on the workstation.

NOTE Choose Print a screenshot to automatically print screenshots of specified alarms for emergency
responders, or Save a screenshot PDF to save a PDF of the screens.

File View Tools Help

& R
@ »a
 Aarm Config

5 MamStatus

[} Archiving
& Fre
£ Account Management

# Fire Configuration

(@ Workstation Config

Mormal Operation

Workstation Configuration

# General & Options for printing from L@ti-View T
Choose Automatic Screenshot Action
e & When a specified alam occurs, the system will automatically:
St Print a screenshot using. | Adobe PDF -
LS Save a screenshot PDF in: [ C:Windows ] @
Otz Print Screen delay (secs) requires restart
5 Event Log
N Select Which Alarms Trigger Automatic Screenshot Action
Lowest Priority | Normal ] ) [MoAction -]
(o ) - o
[Trouble ] T [MoAction -]
(o ) ) ]
[ Comms Trouble ] T [NoAction -]
[Conﬁg Mismatch ] — [NnAcUonj
[ Cause and Effect | - (Mo Action |
[ supervisory | W [noAction -]
[ security | S (Mo Action |
= ) o )
[ mplicit Disablement | S (Mo Action -]
[ Disabiement | . [no Action -]
[(Auxitiary | S (Mo Action |
[ Pre-Atam | W [noAction -] 4
[Fire | S (Mo Action |
[ISRRRE S (PRI | ] &
________________________________________________________________________________________________________________________________|

Logged on as: Administrator Workstation ID: box01a Orline 5/22/2020 2:27:00 PM
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Sound

For audible warnings, select the output device from the drop-down list. Click Test to verify the output.

File View Tools Help

& EH M Normal Operation
®  war Workstation Configuration
% larm Config
Alarm Status 'ﬁ General =
ﬁ Options for L@fi-View audio output
G ardwing & Printing
Sound
& Fre
% Sound
dusprns, B ouon
¥ Fire Configuration = Monitors
@ workstation Config TS
@ Language
% Event Log
« License
Logged on as: Administrator Workstation ID: box01a Online 5/22/2020 2:31:00 PM
1 I
Monitors

Use this page to change or confirm the L@ti-View monitor settings. Select Split Screen and move the slider to
control how much of the available monitor screen width is used by L@ti-View.

@& ER @ Normal Operation

DETECTION
SYSTEMS @ ¢ ®

— Workstation Configuration
£ Alarm Config
4 General
¢ AamStatus - I;| Options for L@ti-View monitors
L Arhiving & Printing
Monitors
& Fre
el Bl = R
# Fire Configuration = Montors Flip mode
@ Workstation Config 2 Alarms [C] Spit Screen -
® Longuage =
% Event Log
« License

Logged on as: Administrator Warkstation ID: box01a Online 5/22/2020 3:26:00 PM

Alarms

Use this page to configure the L@ti-View alarms. Alarms are organized in order of priority and Alarm labels and
colors can be edited by name and color.
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@ DU
£ narm config
Alarm Status
7 Archiving
& Fire
Boaccou

& Fire Configuration

@ workstation Config

£ General
& Printing
% Sound

= Monitors
L. Aarms.
@ Language
% Event Log

« License

Audible Alerts

‘f ! Set-up the alarms and audible alerts.

Alarm Labels and Colors

Workstation Configuration

U Lowest Prioiity | Normal

] )

(info

[roubte

| [

(offine

| [

[ Comms Trouble

| o]

[ Gonfig Mismatch

| o]

[ Cause and Eflect

'supeniisory

(1mpiicit Disablement

Disablement

(Awsitary

(Pre-Alam

[Fire

Highest Priorty | Carbon Monoide

.

QG Qa0 0 ea0caaaqaeaaaqaq

Reset All

File:

1. Click in the field to rename an alarm label.

2. Click on a color swatch to open the Select Color window.

Logged on as: Administrator Workstation ID: box01a Onine §/22/2020 3:30:00 PM

The alarm color can be changed by using the palette of basic colors, by selecting from the color picker, or
entering specific numerical values. Any generated colors can be added to the custom colors palette.

Audible Alerts

Audible alerts can be assigned to alarm events by locating the desired .wav audio file. The Deadband (sound off)
and Interval (sound on) periods can be set in milliseconds (ms) by entering values in the relevant boxes. Audible
Alerts can be previewed by clicking the preview button.

Language

Import and assign language packs relevant to the country or base of operations. Language files must be the *.qm
file type. L@ti-View will be supplied with a default language for the region or country of first use, and additional
languages can be purchased on request. Contact the local distributor or sales person for more information.
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File View Tools Help

@& EhH Normal Operation

® Workstation Configuration

alam Cenfig

Alarm Status ## General

3 arm Status Set active language and install new language packs.

B archiving & Printing = ot

Py e nguage Settings
% Sound

Account Management @ Installed language packs

@ Fire Configuration - Monitors Default language

@ Workstation Config A Aams Engiish (UnitedStates) Active language pack: English (United States)
@ Language

0% Event Log

« License

Import Language Pack

- Select File:

Assign Language and Territory: [Abkh aaaaa j [ j

Logged on as: Administrator Warkstation ID: box01a Orline 5/22/2020 3:31:00 PM
1 1

To import a language pack,

Save the language pack file (*.gm) into the Languages folder in the chosen directory.
From Workstation Config > Language, click Browse.

Find and select the desired language pack file and click Open.

Use the drop-down boxes to select the appropriate language and region.

Click Import and follow the instructions for activating a language pack.

a s wDdh =

To activate a language pack,

1. From Workstation Config > Language, confirm that the required language is installed.
2. Select the desired language and click Activate Language Pack.

To remove a language pack,

NOTE The default language cannot be uninstalled.

1. From Workstation Config > Language, select the desired language.
2. Click Remove Language Pack.

Event Log

The Event Log page is used to configure and schedule the archiving of events. By default, archive events are
saved on the workstation, typically at: C:/users/<username>/documents/L@tiView_archive/alarmeventlog. If
necessary, the archive location can be changed by clicking Change... and specifying another location.

Archive items are retained for the period specified, selected from the ‘Archive items older than’ option.
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File View Tools Help
& BHa Narmal Operation
@ o Workstation Configuration
 Marm Config
G |
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APPENDIX A: KEYBOARD SHORTCUTS

These are the most useful keyboard shortcuts, but other Windows key combinations may also work. Some of
these key combinations are restricted to Editor mode.

Alt-F

Alt-F, X
Alt-[F4]

Alt-H

Alt-H, A
Alt-H, Q
Alt-H, U
Alt-V

Alt-V, S
Alt-Tab

[Del]

[Esc]

[F3]

[F5]
Windows + L
Windows + M

All Modes
Opens the File menu
Opens the Exit dialog
Closes the active window
Opens the Help menu
Opens the ‘About L@ti-View’ window
Opens The Quick Guide in Foxit Reader
Opens The User Manual in Foxit Reader
Opens the View menu
Save Settings
Tab through applications (useful when L@ti-View is in front of other windows)
Delete selected items
Closes the currently open dialog
Opens the Search window
Show / Hide Main GUI
Lock the screen (prevents logging out or closing L@ti-View)

Minimize all windows

Ctrl-A Select All

Ctrl-A, Del Delete All Selected items
Ctrl-C Copy the selected item
Ctrl-G Group the selected items
Ctrl-Shift, G Ungroup the selected items
Ctrl-L Lock the selected items
Ctrl-Shift, L Unlock all items

Ctrl-V Paste the last copied item
Ctrl-S Save Settings

Ctrl-X Cut the selected item

Ctrl-Y Redo the last Undo

Ctrl-Z Undo the last change
Ctrl-Left Click Add to a selection
Ctrl-Page Up Send to front
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Ctrl-Page Down Send to back

Page Up Send forward

Page Down Send backward

Alt-Up arrow Align top

Alt-V Align vertical centers
Alt-C Align horizontal centers
Alt-Down arrow Align bottom

Alt-Left arrow Align left

Alt-Right arrow Align right

Alt-Shift + Up arrow Distribute vertically
Alt-Shift + Left arrow Distribute horizontally

VES Fire Detection Systems
L@ti-View Installation and Configuration Guide
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Default User Group permissions follow the rules below, although users can add additional customized groups if

required. Individual users can belong to multiple groups.

Default Group Name |Description

Administrators Users who administer the L@ti-View system and its components

Maintainers Users who maintain the L@ti-View system and its components

Managers Users who supervise Operators, but with additional powers

Operators Ordinary users of the system, dealing with the day-to-day operation and alerts
ClearAlarmsGroup Users who can clear alarms

ClearHardAlarmsGroup Users who can clear ‘hard’ alarms
EnableDisableAlertsGroup Users who can enable and disable alarm reporting

<Add Group Name> User defined additional groups
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The Tokens listed below have checkboxes that allow authorized users to assign or remove permissions from
individual system group names (see above) when they are installed. They can also be filtered to show the
assigned items only.

Selecting the top-level box for each token selects every component. Selecting and deselecting the top-level box
deselects everything. Expanding the group allows the user to select or deselect individual components in that

group.

NOTE Unavailable tokens are denoted by ‘TBD’ at the top level (in software), and their listed components are
currently unavailable (although selectable). L@ti-View is supplied with many items selected by default, even if that
option is not available. These selections are suggestions only, and are intended to be used as a starting point for
further editing.

2D GUI TBD Adds/Removes full access to the 2D GUI functions
2D GUI 2D GUI Editor Allows the user to launch the 2D Editor
2D GUI 2D GUI Project Settings Allows the user to change the project settings
2D GUI 2D GUI Symbol Library Allows access to the symbol library
2D GUI Edit 2D GUI System Symbols Allows the user to change the system symbol library
ACS TBD Adds/Removes full access to the ACS functions
Allows the user access to the basic Access Control System Functions. Several functions require additional
ACS Access Control GUI o
permissions.
Administration Database Management Editing Allows the user to modify the database management schedules
Administration ~ User Permissions GUI Allows the user to access the User Permissions GUI

Allows the user access to the database management schedules, where the routine (scheduled) archival and clean
Administration ~ Database Management GUI
up of system databases is controlled

Administration ~ Account Management GUI Allows users access to the Account Management GUI

Allows the user access to the alarm configuration tables, where the behavior of individual alarms or groups of
Administration Alarm Configuration GUI
alarms can be tailored to match site requirements

Administration Group point permissions Allows Group point permissions to be managed

Administration Adds/Removes full access to the Administration functions

Administration Per-user permissions Allows permissions to be set on a per-user basis, in addition to being granted to groups

BMS TBD Adds/Removes full access to the BMS functions

BMS Building Management GUI Allows the user access to the basic Building Management System GUI

CCTV Load Monitor Layout Allows the user to load a previously saved CCTV monitor setup

CCTV Tracker Mode Allows the user access to CCTV tracker mode
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CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Save Monitor Layout
Play Sequences

CCTV PA Integration
Modify Monitor Layout
Shared Sequence Editing
User Sequence Editing
Full Sequence Editing
Edit Sequence

Full screen/ Split screen

Cancel Primary CCTV Alarm Event

TBD

CCTVGUI

Full Camera Access

Full Monitor Access
Delete Shared Sequences

Create Shared Sequence

Cancel all CCTV Alarm Events

Delete Any Sequence

Delete Monitor Layout
CCTV Coverage Mode
Maintenance Log

Zone Certificates

Fire Mode

Acknowledge Events
Manual Evacuation
Acknowledge Fire Events
Operational Zone Strategies
Print Procedures

Reset Fire Devices

Fire System Schematics
Silence Fire Device
Historical Events

Simulate Fire

VES Fire Detection Systems
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Description

Allows the user to save the current CCTV monitor setup for later recall

Allows the user to recall and play back a previously saved CCTV sequence (either personal or shared)
Allows the user to trigger PA announcements to the zone covered by a given CCTV camera view
Allows the user to save the current CCTV monitor setup for later recall, overwriting an existing named setup
Allows the user to save changes to shared CCTV sequences

Allows the user to save changes to their own personal CCTV sequences

Allows the user to save changes to any CCTV sequence

Allows the user access to the CCTV Sequence Editor

Allows the user to change a CCTV Monitor between full screen or quad screen modes

Allows the user to all alarm events from a CCTV alarm monitor

Adds/Removes full access to the CCTV functions

Allows the user access to the basic CCTV functions. Several functions require additional permissions.
Allows the user to view all CCTV cameras

Allows the user to control all CCTV displays associated with their current workstation

Allows the user to delete shared CCTV sequences

Allows the user to create new shared CCTV Sequences

Allows the user to delete the current alarm event from a CCTV alarm monitor

Allows the user to delete any CCTV sequence, including shared sequences and personal sequences created by

other users

Allows the user to delete saved monitor setups

Allows the user access to CCTV coverage mode

Allows the user to view the maintenance logs of the Fire System

Allows the user to view the stored certificates (documents) for zone testing on the Fire System
Allows the user access to Fire Mode in the 2D GUI

Allows the user to acknowledge general events

Allows the user to manually evacuate zones from the GUI

Allows the user to acknowledge fire events on the Fire System itself from the GUI

Allows the user to view the stored Operational Zone Strategy documents within the Fire GUI
Allows the user to send stored documents to the printer from the onscreen document viewer
Allows the user to reset equipment on the Fire System (usually the panels) from the GUI
Allows the user to view the configured schematic pages in the Fire GUI

Allows the user to silence the alarms on a device (usually a panel) in the Fire System from the GUI
Allows the user to view historical events on the Fire System

Allows the user to trigger simulated fires, if this function is supported by the Fire Alarm System
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Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

General

General

General

General

General

General

General

General

General

General

System Information Page
Test Fire Zone

Fire GUI

Reception Points

Silenced Buzzer

Find Mode

Fire System Topology View
TBD

Fire Maintenance Functions
Operational Procedures
Generate Reports

View Active Events

View Active Fires

View All Fire Management Info

View Imported Diagrams
Output Control
Poll Analog Value

Manual Refresh

Enable and Disable Equipment

Enable and Disable Zones
Evacuation Strategy GUI
Export Tables

Cause and Effect Strategy GUI
Save Subsystem Filter
Select Mode

Local Alert Volume Control
Suppress Alarm

Change Password

Alarm unacknowledgement
Unsuppress Alarm

Save Column Widths
Export tables to CSV

Pause Alarm History Updates

VES Fire Detection Systems
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Allows the user to access system information in the Fire GUI

Allows the user to access the Test Zone function

Allows the user access to the basic Fire Management GUI. Many functions require additional permissions.
Allows the user to view the stored reception points in the Fire GUI

Allows the user to silence the buzzer on a device (usually a panel) in the Fire System from the GUI
Allows the user to place a device into Find Mode and remove it from that mode.

Allows the user to view a graphical tree of the Fire System devices in their logical hierarchy
Adds/Removes full access to the Fire functions

Allows the user to access the Maintenance pages within the Fire GUI

Allows the user to view the stored Operational Procedure documents within the Fire GUI

Allows the user to generate reports from tables in the GUI

Allows the user to view all active events on the Fire System

Allows the user to view the list of active fire events on the Fire System

Allows the user to access all fire management information pages, the list of active fire events, and all strategy and

policy pages

Allows the user to view the imported evacuation policy diagrams (as pdfs)

Allows the user to set the state of contacts (or digital outputs) in the Fire System if these have been configured
Allows the user to poll an analog value from a device

Allows the user to trigger a discrete read from a device

Allows the user to enable and disable fire devices within the Fire System. This is distinct from disabling them only

within the GUI.

Allows the user to enable and disable entire zones within the Fire System, if the system supports this operation
Allows the user to view the installed Zonal Evacuation strategies

Allows the user to export the data from tables in the Fire GUI to a file

Allows the user to view the installed Cause and Effect strategies

Allows the user to save a selected filter set of subsystems in the main alarm list GUI for later recall
Allows the user to access Select Mode in the 2D GUI

Allows the user to access the local volume control for audible alerts generated by the GUI

Allows the user to suppress an alarm from the main alarm list

Allows the user to change their own password through the GUI

Allows the user to ‘unacknowledge’ alarms

Allows the user to ‘unsuppress’ an alarm from the main alarm list

Allows the user to save the current table column widths in the GUI via the save settings menu option
Allows the user to export the text of standard tables in the GUI to .csv files

Allows the user to pause automatic updates of the Alarm History View
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General
General
General
General
General
General

General

General

General

General
General
IP Networking
IP Networking

L@ti-View

Message Board

Message Board
Message Board

Message Board

Message Board

Message Board

Message Board

PA/VA

PA/VA
PA/VA
PA/VA
PA/VA
PA/VA
PA/VA

PA/VA

General Table Write Access
Exit GUI

Delete Subsystem Filter
Operator Alarms Only

Clear Alarm Caches

Clear Alarms

Enable Alarm Reporting

Disable Alarm Reporting

Clear Hard Trouble s

Alarm acknowledgement
TBD
TBD
Network Monitoring GUI

L@ti-View 2D GUI

Message Board Full Access

Delete Messages
Edit Messages

Post Messages

Message Board GUI

View Messages

TBD

Ad Hoc Message Trigger

Soft Push-To-Talk (Emergency)

Audio Message Support

Zone Overrides Table

Background Music Source Select

Display Brightness Override
Night Volume Override

Soft Push-To-Talk

VES Fire Detection Systems
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Description

Allows the user to edit database tables that do not have a specific access permission

Allows the user to exit from the GUI

Allows the user to delete custom subsystem filters from the main alarm list GUI

If set to >99, the user will not see low-level trouble reports

Allows the user to clear the cache of alarm data, which must be done to enable the ‘Unsuppress Alarm’ option
Allows the user to attempt to clear alarms

Allows the user to re-enable alarm/trouble reporting from items of equipment. (See Disable Alarm Reporting)

Allows the user to disable alarm/trouble reporting from items of equipment. This might be used during maintenance

procedures or in response to spurious (nuisance) troubles.

Allows the user to attempt to clear troubles that have been defined as ‘Hard Troubles’, which are troubles that
require a higher privilege level to clear as a clearance attempt may have particular side effects that must be

understood

Allows the user to acknowledge alarms

Adds/Removes full access to the General functions
Adds/Removes full access to the IP Network functions
Allows basic access to |P Network monitoring functions
Allows the user access to the L@ti-View self-monitoring GUI

Grants the user all permissions within the message board GUI. (Has the same effect as ticking all the individual

permissions in this section.)

Allows the user to delete posted messages

Allows the user to edit posted messages

Allows the user to post new messages on the message board

Allows the user to access the built-in Message Board GUI, where users can leave messages for each other (e.g.

at shift hand-over)
Allows users to read messages
Adds/Removes full access to the Message Board functions

Allows the user to trigger messages (audio or display) from the GUI. Without this permission only live

announcements or scheduled messages can be played.

Allows the user to make emergency live PA announcements from the GUI
Allows the user to select and trigger audio messages

Allows the user to access the Zone Overrides Table

Allows the user to access the BGM source column in Zone Overrides

Allows the user to access the Display Brightness column in Zone Overrides
Allows the user to access the Night Volume Override column in Zone Overrides

Allows the user to make live PA announcements from the GUI
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PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PHP

PHP

PHP

PA/VA GUI Pin Management

Message Builder Display

Messages

Quick Messages

Message Scheduling

Maximum Scheduled PA Message

Priority

TTS Messages

Display Message Support
Message Builder Audio Messages
Message Management

2D PA/VA Map support (Legacy)
Message Builder

TBD

Advanced PA schedule settings
Edit PA Schedules

Enable / Disable PA schedules
View PA Schedule details
Modify Messages

Listen In Mode

BGM Access

Routine Messages Control (legacy)
PA Coverage Access
Emergency Message Button

PA Access

PA Mute Access

Play Message Button

PA/VA GUI

Zone Group Select Button

PIDS Access

Transfer Help Point Calls

Show All Help Point Call Log Info

Show All Help Point Address Book

Info

VES Fire Detection Systems
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Allows the user to change the security PIN on the PA/VA GUI, if it has been enabled in system configuration
Allows the user to build messages for information display units in the Message Builder

Allows the user to access the ‘Quick Message’ feature, where messages can be triggered from a single dedicated

button

Allows the user access to the PA/VA Scheduler GUI
Allows the user to prioritize scheduled PA messages (100 = maximum priority)

Allows the user to create and save Text-to-Speech (TTS) messages

Allows the user to select and trigger display messages (e.g. on visual information displays)
Allows the user to build audio messages in the Message Builder

Allows the user access to PA/VA Message Management to record, rename, and delete messages
Allows the user to access the legacy 2D PA map

Allows the user to access the PA/VA Message Builder

Adds/Removes full access to the PA/VA functions

Allows the user to access all of the advanced settings on a PA/VA schedule

Allows the user to edit the details of PA/VA schedules

Allows the user to enable and disable (but not edit) PA/VA schedules

Allows the user to view the details of PA/VA schedules

Allows the user to modify existing audio or display messages

Allows the user to access Listen In Mode in the 2D/3D GUI

Allows the user to control background music (on/off) in the main GUI

Allows the user to access the Routine Messages Suppression column in Zone Overrides

Allows the user to view PA coverage in the main GUI

Allows the user to access the Emergency Message button in the 2D GUI

Allows the user to access PA Mode. If the user also has access to PIDS mode, then the unified PIS mode is used
Allows the user to control PA Mute on/off in the main GUI

Allows the user to access the Play Message button in the 2D GUI

Allows access to basic PA/VA functions. Advanced functions require additional permissions.
Allows the user to access the zone group select buttons in the 2D GUI

Allows the userto access PIDS mode. If the user also has access to PA mode, then the unified PIS mode is used
Allows the user to transfer a help point call to the external line

Allows the user to see all data columns in the help point call log

Allows the user to see all data columns in the help point Address Book
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PHP

PHP

PHP

PHP

PHP

PHP

PHP

PHP

PHP

PHP

PIS

PIS

PIS
Schematics
Schematics
Special
Special
Special
Special
Telephony

Telephony

Telephony

Telephony
Telephony
Telephony
Telephony
Telephony
Voice Recorder
Voice Recorder
Voice Recorder
Voice Recorder

Voice Recorder

Take Help Point Call off Hold
Make Outgoing Help Point Call
Help Point Call Log

Hang up Help Point Call

Help Point Outgoing Call Page
Answer Help Point Calls

Help Point GUI

TBD

Place Help Point Call on Hold
Mute Help Point Call

DDU Test Mode

Assign DDU Profile

TBD

TBD

Schematics Page Selection
TBD

Full Control

Message Builder Diagnostic Panel

Message Management Information

Enable Speed Dialler

Address Book Extended View

Make Telephone Calls

Delete Telephony Contact
Add Telephony Contact
Telephony GUI

TBD

Edit Telephony Contact
TBD

Delete Voice Recordings
Play Voice Recordings
Save Voice Recordings

Voice Recording System GUI
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Description

Allows the user to resume a help point call that has been placed on hold
Allows the user to make an outgoing call to a help point

Allows the user to view the help point call log

Allows the user to hang up an incoming help point call, once answered
Allows the user to view the help point outgoing call page (the ‘address book’ of help points)
Allows the user to answer incoming help point calls

Allows access to basic Help Point Functions

Adds/Removes full access to the PHP functions

Allows the user to put a help call on hold

Allows the user to mute/unmute a help point call

Allows the user to put the DDU into test mode

Allows the user to assign a display profile to a Data Display Unit

Adds/Removes full access to the PIS functions

Allows the user to view the drop-down list of schematics in the Schematics GUI
Adds/Removes full access to the Special functions

Allows access to all features and GUIs

Allows the user to see the diagnostic panel in the PA/VA Message Builder GUI
Allows the user to see the diagnostic panel in the PA/VA Message Management GUI
Allows the user to access the configurable ‘Speed Dial’ buttons in the Telephony GUI
Allows the user to see all data columns in the Address Book

Allows the user access to the Make Calls page in the Telephony GUI, and thus make calls from the SIP phone

associated with their workstation.

Allows the user to delete contacts from the Telephony Address Book

Allows the user to add new contacts to the Telephony Address Book

Allows the user access to the basic telephony functions. Advanced functions require additional permissions
Adds/Removes full access to the Telephony functions

Allows the user to edit contacts in the Telephony Address Book

Adds/Removes full access to the Voice Recorder functions

Allows the user to delete recordings made by the Voice Recorder System

Allows the user to play recordings made by the Voice Recorder System

Allows the user to save recordings made by the Voice Recorder System to an external or networked drive

Allows the user access to the Voice Recording System functions
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No dongle, or dongle license is Fita current dongle before launching

L@ti-View will not start.

The screen does not appear right.

The desired panel cannot be located.

L@ti-View closed unexpectedly.

The wrong symbols are displaying in the Symbol
Library.

Previously deleted symbols are now duplicated.

L@ti-View hangs during symbol loading.

VES Fire Detection Systems

L@ti-View Installation and Configuration Guide

out of date.

L@ti-View is not compatible
with the OS.

New installation

Changes were made and
saved by the last user.

Changes were made and not
saved.

Panels docked in the same
space will be stacked up.

The Bootstrap CMD window
was closed by mistake and
unsaved changes were lost.

This action cannot be reversed.

The Symbols library wasn’t
refreshed between Delete and
Import.

Make a note of the error
message and close L@ti-View
by closing the CMD window.
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L@ti-View.

Install L@ti-View on a Windows 7
system or later.

Either load a project or create and save
a new one.

Load a previously saved version and
save it.

Make the changes again and save
them.

Select the desired panel on the tab at
the bottom of the dock area.

Restart L@ti-View. Save regularly
during edits. Save versions if making a
lot of changes.

Import fresh symbols and their
ancillaries from the PC or workstation.

Restart L@ti-View without saving the
current changes.

Load an earlier saved version.

Close the Symbols Library between
tasks.

Manually delete the offending image
file from the directory folder and retry
loading the L@ti-View project.
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B
Buzzer 61, 96

E
EventLog 16, 70

L
Loop Explorer2 10

N
Network 10, 44, 81

P

Printer 86, 95
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leti-view Q)

2

2D

Two Dimensional on the x-y axis

3

3D

Three Dimensional on the x-y-z axis

A

ACID
Access Control and Intruder Detection

ANS

Ambient Noise Sensor

BGM
Background Music

BGU

Break Glass Unit (fire alarm)

BMS
Building Management System

C

CAE

Cause and Effect

CIS

Customer Information Sensor

VES Fire Detection Systems
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Ccsv
Comma Separated Values; the .csv file type allows files to be imported into columns and
rows in spreadsheets and databases

D

DDU
Data Display Unit

DIP

Dynamic IP address

E

End-Of-Line Device (EOLD)
An electronic component physically installed as the furthest device from the control panel,;
whose presence on the circuit is used to monitor the integrity of the circuit.

EOL

End Of Line (e.g. alarms, CCTV, detectors, sounders, speakers)

EOLR

End-of-Line Resistor

F
FACS

Fire Alarm Control System

FAS

Fire Alarm Control System

G
GUI

Graphical User Interface

GUID
Globally Unique Identifier used to identify equipment on a network
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/10
Input / Output

IP

Internet Provider (networking)

L

LAN
Local Area Network

LLPA
Long Line Public Address

N
NAC

Notification Appliance Circuit. A supervised output circuit that connects horns, strobes,
speakers, etc. to the control panel.

P

PA
Public Address

PIDS
Passenger Information Display System

px
pixel

S

SIP
Static IP Address
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SIP2
Session Initiation Protocol (SIP) is a communications protocol for signalling and controlling
multimedia communication sessions in applications of Internet telephony for voice and
video calls, in private IP telephone systems, as well as in instant messaging over Internet
Protocol (IP) networks.

SLC
Signaling Line Circuit. A Signaling Line Circuit (SLC) carries data to and from the field
devices for the fire alarm system, and also carries power from the control panel to the

devices.

SMS
Station and building Management System / Site Management System

SOP
Site (or Standard) Operating Procedures

T

TCP/IP
Transmission Control Protocol/Internet Protocol

U

UAC
User Account Control (Microsoft)

X

X-y axis
x -y refers to screen pixel coordinates based on the available screen resolution (e.g. 1920 x
1080). X = the horizontal screen axis drawn left-to-right, and Y = the vertical screen axis
drawn top-to-bottom. A VDU’s nominal point of origin (x =0, y = 0) is positioned at the top
left of the screen, so a screen item’s nominal point of origin might be stipulated (in code) as
[x =x+100;y =y + 100].
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V4

z-axis
z refers to a virtual axis running tangentially to the x-y axes; x-y-z coordinates can be used
to create 3D objects that can pan, tilt, and rotate in virtual 3-dimensional space.

z-order
Incident priorities are allocated to default layers arranged, in descending order, on the z-
axis. In other words, the highest current priority (e.g. Fire) cannot be obscured by items of
lower priority.

z-index
Incident priorities are allocated to default layers arranged, in descending order, on the z-
axis. In other words, the highest current priority (e.g. Fire) cannot be obscured by items of
lower priority.
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